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UNIT 1 

 

1. Which function calculates the largest value in a set of numbers? 
(1) Average 

(2)Count 
(3)Minimum 

(4)Maximum 

(5)None of these 

Ans: (4) 

 

2. What do you use to create a chart? 
(1)Pie Wizard 

(2)Excel Wizard 

(3)Data Wizard 

(4)Chart Wizard 

(5)None of these 

Ans: (4) 

 

3. What displays the content of the active cell? 
(1)Name box 

(2)Row Headings 
(3)Formula bar 
(4)Task pane 

(5)None of these 

Ans: (3) 

 

4. By default, your documents print in _mode. 
(1)Landscape 

(2)Portrait 
(3)Page Setup 

(4)Print View 

(5)None of these 

Ans: (2) 

 

5. What is the best way to have a data and the slide number appear on every slide ? 
(1) choose Tools, Header and Footer, click Slide tab, select the desired options, click Apply to 

All 
(2) choose Insert, Header and Footer, click Slide tab, select the desired options, click Apply to 

All 
(3) chouse View, Header and Footer, click Slide tab, select the desired options, click Apply to 

All 
(4) choose File, Header and Footer, click Slide tab, select the desired options, click Apply to 

All 
(5) None of these 

Ans: (2) 
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6.To move to the bottom of a document, press _. 
(1) Insert key 

(2) Home key 

(3) Ctrl key + End key 

(4) End key 

(5) None of these 

Ans: (3) 

 

7.Which one of the following four words is odd? 
(1)Application 

(2)Peripheral 
(3)Programme 

(4)Software 

(5)None of these 

Ans: (2) 

 

8. If formation of computer, the hardwares......... are used. 
(1) Monitor, Central Processing Unit (CPU), Keyboard, Mouse, Software and Network 

(2) Monitor, Central Processing Unit (CPU), Keyboard, Mouse Programme and Network 

(3) Monitor, Central Processing Unit (CPU), Keyboard, Mouse, Printer and Modem 

(4) Monitor, Central Processing Unit (CPU), Keyboard, Mouse, Application and Network 

(5) None of these 

Ans: (3) 

 

9.In page preview mode- 
(1) You can see all pages of your document 
(2)You can only see the page you are currently working 

(3)You can only see pages that do not contain graphics 
(4)You can only see the title page of your document 
(5)None of these 

Ans: (1) 

 

10.A CPU contains- 
(1) a card reader and a printing device 

(2) an analytical engine and a control unit 
(3) a control unit and an arithmetic logic unit 
(4) an arithmetic logic unit and a card reader 
(5) None of these 

Ans: (3) 

 

 

11. Which of the following controls the process of interaction between the user and the 

operating system? 
(1) User interface 

(2) Language translator 
(3) Platform 

(4) Screen saver 
(5) None of these 

Ans: (1) 
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12.You will work on which groupings, while formatting the text in word? 
(1) Table, paragraph and index 

(2) Paragraph, index and section 

(3) Character, paragraph and section 

(4) Index, character and table 

(5) None of these 

Ans: (2) 

 

13.When you want to move some text from one page to a different page, the best method is- 
(1) drag and drop (2) cut and paste (3) delete and retype (4) find and replace (5) None of 
these 

Ans: (2) 

 

14.The first computers were programmed using- 
(1) assembly language 

(2) machine language 

(3) source code 

(4) object code 

(5) spaghetti code 

Ans: (2) 

 

15.How many are the margins on page? 
(1) Two (header and footer) 
(2) Four (Upper, lower, right, left) 
(3) Two (Landscape, portrait) 
(4) Two (Upper and lower) 
(5) None of these 

Ans: (2) 

 

16.  An is a combination of hardware and software that facilitates the sharing of information 

between computing devices. 
(1) network 

(2) peripheral 
(3) expansion board 

(4) digital device 

(5) None of these 

Ans: (1) 

 

17.  The settings are automatic and standard. 
(1) icon 

(2) default 
(3) CPU 

(4) peripheral 
(5) None of these 

Ans: (2) 
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18.  Coded entries which are used to gain access to a computer system are called- 
(1) Entry codes 
(2) Passwords 
(3) Security commands 
(4) Code words 
(5) None of these 

Ans: (2) 

 

19.To view information on the web you must have a- 
(1) cable modem 

(2) web browser 
(3) Domain Name Server 
(4) hypertext viewer 
(5) None of these 

Ans: (2) 

 

20.Which of the following commands is given to reboot the 

computer? 

1) Ctrl + Alt + Del 
2) Ctrl + Shift + ? 
3) Ctrl + Shift + Del 
4) Ctrl +Alt + shift 
5) Ctrl + Alt + Tab 

Ans: (1) 

 

21.  By default, your documents print in _ mode .  
1) Landscape 

2) Portrait 
3) Page Setup 

4) Print View 

5) None of these 

Ans: (2) 

 

22.  To find and load a file that has been saved _. 

1) select the Close command 

2) select the New command 

3) select the Save command 

4) select the Open command 

5) None of these 

Ans: (4) 

 

23.Which function calculates the largest value in a set
 of numbers? 

1) Average 

2) Count 
3) Minimum 

4) Maximum 

5) None of these 

Ans: (4) 
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24.  Which o f the following statements is true ? 

1) Minicomputer works faster than Microcomputer 
2) Microcomputer works faster than Minicomputer 
3) Speed of both the computers is the same 

4) The speeds of both these computers cannot be compared with the speed of advanced 

computer 
5) None of these 

Ans: (1) 
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UNIT 2 

 

1. Selection of command- 
(A) Opens the copy of the document in preview 

(B) Prints the copy of displayed document 
(C) Brings change in expansion of displayed document 
(D) Saves the copy of displayed document 
(E) None of these 

Ans: (C) 
 

2. You organize files by storing them in- 
(A) archives 
(B) folders 
(C) indexes 
(D) lists 
(E) None of these 

Ans: (B) 
 

3. How many different documents can you have open at any one time ? 
(A) No more than three 

(B) Only one 

(C) As many as your computer memory will hold 

(D) No more than you taskbar can display 

(E) None of these 

Ans: (C) 
 

4. What type of resource is most likely to be a shared common resource in a computer 
network? 
(A) Printers 
(B) Speakers 
(C) Floppy disk drives 
(D) Keyboards 
(E) None of these 

Ans: (A) 
 

5. Directory in directory is called- 
(A) Mini directory 

(B) Junior directory 

(C) Part directory 

(D) Sub-directory 

(E) None of these 

Ans: (D) 
 

6. Such a pre-made document, which has coordinating font, layout and background, is- 
(A) Guide 

(B) Model 
(C) Ruler 
(D) Template 

(E) None of these Ans: (D) 
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7. In order to create columnar data in Word you need to- 
(A) Tab consecutively until your cursor reaches the desired place 

(B) Set tabs or use the Table menu 

(C) You need to use Excel 
(D) Press the space bar until your cursor reaches the desired place 

(E) None of these 

Ans: (E) 
 

8. Saving is a process- 
(A) To copy the document from memory to storage medium 

(B) To bring change in present status of the document 
(C) To change the face or entire form 

(D) To develop the document by recording the text with the use of keyboard 

(E) None of these 

Ans: (A) 
 

9. To insert a word into the middle of a sentence- 
(A) move the cursor to the desired location in the sentence and type the new word 

(B) move the cursor to the desired location in the sentence, press Enter key, and type the new 

word 

(C) move the cursor to the beginning of the sentence and start typing 

(D) retype the whole sentence 

(E) None of these 

Ans: (A) 
 

10. A(n) ..............  is a combination of hardware and software that facilitates the sharing of 
information between computing devices. 
(A) network 

(B) peripheral 
(C) expansion board 

(D) digital device 

(E) None of these 

Ans: (A) 
 

11. In word you can force a page break- 
(A) By positioning your cursor at the appropriate place and pressing the F1 key 

(B) By using the Insert/Section Break 

(C) By positioning your cursor at the appropriate place and pressing Ctrl + Enter 
(D) By changing the font size of your document 
(E) None of these 

Ans: (C) 
 

12. Junk e-mail is also called- 
(A) spam 

(B) spoof 
(C) sniffer script 
(D) spool 
(E) None of these 

Ans: (A) 
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13. Hackers- 
(A) all have the same motive 

(B) break into other people's computers 
(C) may legally break into computers as long as they do not do any damage 

(D) are people who are allergic to computers 
(E) None of these 

Ans: (B) 
 

14. What type of computers are client computers (most of the time) in a client-server system? 
(A) Mainframe 

(B) Mini-computer 
(C) Microcomputer 
(D) PDA 

(E) None of these 

Ans: (C) 
 

15. A computer cannot 'boot' if it does not have the- 
(A) Compiler 
(B) Loader 
(C) Operating System 

(D) Assembler 
(E) None of these 

Ans (C) 
 

16. The amount of vertical space between lines of text in a document is called- 
(A) double-space 

(B) line spacing 

(C) single space 

(D) vertical spacing 

(E) None of these 

Ans: (B) 
 

17. Example of non-numeric data is- 
(A) Employee address 
(B) Examination score 

(C) Bank balance 

(D) All of these 

(E) None of these 

Ans: (A) 
 

18. What is embedded system? 
(A) The programme which arrives by being wrapped in box. 
(B) The programme which is the permanent part of the computer 
(C) The computer which is the part of a big computer 
(D) The computer and software system that control the machine 

(E) None of these 

Ans: (D) 
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19. First page of Website is termed as- (A) Homepage 

(B) Index 

(C) JAVA script 
(D) Bookmark 

(E) None of these 

Ans: (A) 
 

20. .....................  is the appearance of typed characters. 
(A) Size 

(B) Format 
(C) Point 
(D) Colour 
(E) None of these 

Ans: (B) 
 

21. When a file is saved for the first time- 
(A) a copy is automatically printed 

(B) it must be given a name to identify it 
(C) it does not need a name 

(D) it only needs a name if it is not going to be printed 

(E) None of these 

Ans: (B) 
 

22. Office LANS, which are scattered geographically on large scale, can be connected by the use of corporate- 
(A) CAN 

(B) LAN 

(C) DAN 

(D)WAN 

(E) TAN 

Ans: (D) 
 

23. Where are data and programme stored when the processor uses them? 
(A) Main memory 

(B) Secondary memory 

(C) Disk memory 

(D) Programme memory 

(E) None of these 

Ans: (A) 
 

24. ............... represents raw facts, where- as .................  is data made meaningful. 
(A) Information, reporting 

(B) Data, information 

(C) Information, bits 
(D) Records, bytes 
(E) Bits, bytes 
Ans: (B) 
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25. Which keystroke will take you at the beginning or the end of a long document? 
(A) Ctrl + PageUp and Ctrl + PageDown 

(B) Shift + Home and Shift + End 

(C) Ctrl + Home and Ctrl + End 

(D) The only way is by using the right scroll bar 
(E) None of these 

Ans: (C) 
 

26. What characteristic of read-only memory (ROM) makes it useful? 
(A) ROM information can be easily updated. 
(B) Data in ROM is nonvolatile, that is, it remains there even without electrical power. 
(C) ROM provides very large amounts of inexpensive data storage. 
(D) ROM chips are easily swapped between different brands of computers. 
(E) None of these 

Ans:(B) 
 

27. In page preview mode- 
(A) You c a n s e e a l l p a g e s o f your document 
(B) You can only see the page you are currently working 

(C) You can only see pages that do not contain graphics 
(D) You can only see the title page of your document 
(E) None of these 

Ans: (A) 
 

28. If the file saved earlier is edited, then- 
(A) It is essential to save the file again to store the change 

(B) The change will automatically be saved in the file 

(C) If the length is more than a page, the file will be needed to be saved 

(D) The name will be needed to be changed 

(E) None of these 

Ans: (A) 
 

29. When creating a word-processed document, this step involves the user changing how words on the page 

appear, both on the screen and in printed form- 
(A) Editing text 
(B) Inserting tables and indexes 
(C) Formatting text 
(D) Proofing documents 
(E) None of these 

Ans: (C) 
 

30. Aligning of text in column is- 
(A) Justified 

(B) Right 
(C) Centre 

(D) Left 
(E) None of these 

Ans: (A) 
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UNIT 3 

 

1. Computer uses the ..........  number system to store data and perform calculations. 
(1) binary (2) octal 
(3) decimal (4) hexadecimal (5) None of these 

 

2. A disk's content that is recorded at the time of manufacture and that cannot be changed or erased by the 

user is- 
(1) Memory- only (2) Write-only 

(3) Once- only (4) Run-only (5) Read-only 

 

3. Which of the following can be used to select the entire document? 
(1) CTRL + A (2) ALT + 5 

(3) SHIFT + A (4) CTRL + K (5) CTRL + H 

 

4. ..........  are attempts by individuals to obtain confidential information from you by falsifying their 
identity. 
(1) Phishing (2) Computer viruses 
(3) Spyware scams (4) Viruses (5) None of the above 

 

5. Part number, part description, and number of parts ordered are examples of 
(1) control (2) output 
(3) processing (4) feedback (5) input 
 

6. A Web site's main page is called its- 
(1) Home Page (2) Browser Page 

(3) Search Page (4) Bookmark (5) None of these 

 

7. The simultaneous processing of two or more programs by multiple processors is- 
(1) multiprogramming (2) multitasking 

(3) time-sharing (4) multiprocessing (5) None of these 

 

8. Codes consisting of lines of varying widths or lengths that are computer-readable are known as- (1) an ASC 

code (2) a magnetic tape 

(3)an OCR scanner (4) a bar code (5) None of these 

 

9. To instruct Word to fit the width of a column to the contents of a table automatically, click the..... button 

and then point to AutoFit Contents. 
(1) Fit to Form (2) format 
(3) Auto size (4) Contents (5) AutoFit 
 

10. Why is it unethical to share copyrighted files with your friends? 
(1) It is not unethical, because it is legal. 
(2) It is unethical because the files are being given for free. 
(3) Sharing copyrighted files without permission breaks copyright laws. 
(4) It is not unethical because the files are being given for free. 
(5) It is not unethical-anyone can access a computer 
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11. Reusable optical storage will typically have the acronym- 
(1) CD (2) DVD 

(3) ROM (4) RW (5) ROS 

 

12. The most common type of storage devices are- 
(1) persistent (2) optical 
(3) magnetic (4) flash (5) steel 
 

13. A device that connects to a network without the use of cables is said to be- 
(1) distributed (2) free 

(3) centralized (4) open source (5) None of these 

 

14. A person who used his or her expertise to gain access to other people's computers to get information 

illegally or do damage is a- 
(1) hacker (2) analyst 
(3) instant messenger (4) programmer (5) spammer 
 

15. To access properties of an object, the mouse technique to use is- 
(1) dragging (2) dropping 

(3) right-clicking (4) shift-clicking (5) None of these 

 

16. To change selected text to all capital letters, click the change case button, then click- 
(1) UPPERCASE (2) UPPER ALL 

(3) CAPS LOCK (4) Lock Upper (5) Large Size 

 

17. The basic unit of a worksheet into which you enter data in Excel is called a- 
(1) tab (2) cell 
(3) box (4) range (5) None of these 

 

18. You can keep your personal files / folders in- 
(1) My folder (2) My Documents 
(3) My Files (4) My Text (5) None of these 

 

19. In Word you can force a page break- 
(1) By positioning your cursor at the appropriate place and pressing the F1 key 

(2) By positioning your cursor at the appropriate place and pressing Ctrl + Enter 
(3) By using the Insert/Section Break 

(4) By changing the font size of your document 
(5) None of these 

 

20. A DVD is an example of a(n)- 
(1) hard disk (2) optical disc 

(3) output device (4) solid-state storage device 

(5) None of these 

 

21. The default view in Excel is .........  view. 
(1) Work (2) Auto 

(3) Normal (4) Roman (5) None of these 
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22. The process of transferring files from a computer on the Internet to your computer is called 

(1) downloading (2) uploading 

(3) FTP (4) JPEG (5) downsizing 

 

23. ..........  is the process of dividing the disk into tracks and sectors. 
(1) Tracking (2) Formatting 

(3) Crashing (4) Allotting (5) None of these 

 

24. Help Menu is available at which button? 
(1) End (2) Start 
(3) Turnoff (4) Restart (5) Reboot 
 

25. The contents of ..........  are lost when the computer turns off. 
(1) storage (2) input 
(3) output (4) memory (5) None of these 

 

26. When you enter text in a cell in Excel, it also appears in which of the following? 
(1) Status bar (2) Formula bar 
(3) Row heading (4) Name box (5) None of these 

 

27. Which elements of a Word document can be displayed in colour? 
(1) Only graphics (2) Only text 
(3) Only the first word of each line 

(4) All elements, but only if you have a colour printer 
(5) All elements 
 

28. A workbook is a collection of 
(1) Page Setup (2) Buttons 
(3) Diagrams (4) Charts (5) Worksheets 
 

29. appear at the bottom of the Excel Window. 
(1) Sheet tabs (2) Name Box 

(3) Formula bar (4) Title bar (5) None of these 

 

30. EPROM stands for 
(1) Erasable Programmable Read-Only Memory 

(2) Electronic Programmable Read-Only Memory 

(3) Enterprise Programmable Read- Only Memory 

(4) Extended Programmable Read-Only Memory 

(5) Electrical Programmable Read-Only Memory 

 

31. The technology that stores only the essential instructions on a microprocessor chip and thus enhances its 
speed is referred to as 
(1) CISC (2) RISC 

(3) CD-ROM (4) Wi-Fi (5) MISC 

 

32. Which is not a basic function of a computer? 
(1) Store data (2)Accept input 
(3)Process data (4) Copy text (5) Accept and process data 
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33. ASC is a coding system that provides 
(1) 256 different characters 
(2) 512 different characters 
(3) 1024 different characters 
(4) 128 different characters 
(5) 1000 different characters 
 

34. Which part of the computer is directly invoked in executing the instructions of the computer 
program? 
(1) The scanner 
(2) The main storage 

(3) The secondary storage 

(4) The printer 
(5) The processor 
 

35. In order to create column data in Word, you need to 

(1) tab consecutively until your cursor reaches the desired place 

(2) set tabs or use the Table menu 

(3) use Excel 
(4) press the space bar until your cursor reaches the desired place 

(5) None of these 

 

36. Files are organised by storing them in 

(1) tables 
(2) databases 
(3) folders 
(4) graphs 
(5) diagrams 
 

37. When a computer is switched on, the booting process performs 
(1) Integrity Test 
(2) Power-On Self-Test 
(3) Correct Functioning Test 
(4) Reliability Test 
(5) Shut-down 

 

38. In Word, the feature that automatically detects common errors is called 

(1) Autocorrect 
(2) Autograph 

(3) Spelling and Grammar 
(4) Go to 

(5) Thesaurus 
 

39. A computer system that is old and perhaps not satisfactory is referred to as a(n) 
(1) Ancient system 

(2) Historical system 

(3) Age old system 

(4) Legacy system (5) Legal System 
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40. Which of the following is not a binary number? 
(1) 001 

(2) 101 

(3) 202 

(4) 110 

(5) 011 

 

41. Which of the following does not store data permanently? 
(1) ROM (2) RAM 

(3) Floppy Disk 

(4) Hard Disk 

(5) None of these 

 

42. Which of the following is the smallest storage? . 
(1) Megabyte 

(2) Gigabyte 

(3) Kilobyte 

(4) Terabyte 

(5) None of these 

 

43. Which menu enables the user to choose toolbars? 
(1) View 

(2) Format 
(3) Insert 
(4) Edit 
(5) Help 

 

44. By viewing the properties of the local hard disk of a computer, the user can find out 
(1) the amount of space that has been used up and the remaining free space on the disk. 
(2) the name of the user viewing the properties of the disk. 
(3) nothing useful to the user. 
(4) the number of programs available in the computer, (5) None of these 

 

45. Pre-defined and built-in formulas in Excel are known as 
(1) Auto sheets 
(2) Diagrams 
(3) Charts 
(4) Tables 
(5) Functions 
 

46. Which of the following contains permanent data and gets updated during the processing of transactions? 
(1) Operating System File 

(2) Transaction file 

(3) Software File 

(4) Master file 

(5) Any File 
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47. The keyboard shortcut to centralise the selected text in Word is 
(1) Ctrl + Esc 

(2) Ctrl + C 

(3) Alt + C 

(4) There is no keyboard shortcut for this operation 

(5) Ctrl + E 

 

48. Which of the following helps to protect floppy disks from data getting accidentally erased? 
(1) Access notch 

(2) Write-protect notch 

(3) Entry notch 

(4) Input notch 

(5) None of these 

 

49. A modem is connected to 

(1) a telephone line 

(2) a keyboard 

(3) a printer 
(4) a monitor 
(5) a scanner 
 

50. Large transaction processing systems in automated organisations use 

(1) Online processing 

(2) Batch Processing 

(3) Once-a-day Processing 

(4) End-of-day processing 

(5) Once-a-week processing 

 

51. The operation of combining two cells into a single cell in Excel is referred to as 
(1) Join cells 
(2) Merge cells 
(3) Merge table 

(4) Join table 

(5) None of these 

 

52. Which of the following can be used to store a large number of files in a small amount of storage space? 
(1) File adjustment 
(2) File copying 

(3) File reading 

(4) File compatibility 

(5) File compression 

 

53. In a computer, most processing takes place in 

(1) Memory 

(2) RAM 

(3) Motherboard 

(4) CUP 

(5) None of these 
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54. Data is organized in a worksheet as 
(1) charts and diagrams 
(2) rows and columns 
(3) tables and boxes 
(4) graphs 
(5) None of the above 

 

55. Which of the following is an example of a binary number? 
(1) 6AH1 

(2)100101 

(3) 005 

(4) ABCD 

(5)23456 

 

56. Spell Check will find errors in which of the following? 
(1) Today is a rainy day 

(2) Today is a rainy a day 

(3) Is a rainy 

(4) Rainy today a day 

(5) None of the above 

 

57. Which of the following is not a storage medium? 
(1) Hard disk 

(2) Flash drive 

(3) DVD 

(4) CD 

(5) Keyboard 

 

58. In Excel, when the contents and attributes of a cell or range of cells have to be erased using the menu, 
the user must 
(1) select the Cells. choose Edit. and select Clear, then All 
(2) select the Cells. and click Delete on the keyboard 

(3) select the Cells. choose Tools. and select Clear. then Formats 
(4) select the Cells. choose Tools. and select Formula Audit. then Delete 

(5) None of the above 

 

59. The computer abbreviation KB usually means 
(1) Key Block 

(2) Kernel Boot 
(3) Kilo Byte 

(4) Kit Bit 
(5) None of these 

 

60. If an Excel Worksheet is to be linked for use in a Powerpoint presentation, the following should be clicked 

(1) Edit, Paste Special 
(2) Edit, Paste 

3) Edit, Copy 
(4) File, Copy (5) None of the above 
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61. RAM stands for 
(1) Random Access Memory 

(2) Ready Application Module 

(3) Read Access Memory 

(4) Remote Access Machine 

(5) None of the above 

 

62. Which of the following is the hardware and not the software? 
(1) Excel 
(2) Printer driver 
(3) Operating system 

(4) Powerpoint 
(5) Control Unit 
 

63. In Word, which menu would the user select to print a document? 
(1) Tools 
(2) File 

(3) View 

(4) Wind0Vob 

(5) None of these 

 

64. Which of the following is not true about computer files? 
(1) They are collections of data saved to a Storage medium 

(2) Every file has a filename 

(3) A file extension is established by the user to indicate the date it was created 

(4) Usually files contain data 

(5) None of the above 

 

65. The common name for a modulator-demodulator is 
(1) Modem 

(2) Joiner 
(3) Networker 
(4) Connector 
(5) Demod 

 

66. What do you see when you click the right mouse button? 
(1) The same effect as the left click 

(2) A special menu 

(3) No effect 
(4) A mouse cannot be right clicked 

(5) Computer goes to sleep mode 

 

67. In order to choose the font for a sentence in a Word document, 
(1) select Font in the Format menu 

(2) select Font in the Edit menu 

(3) select Font in the Tools menu 

(4) select Font in the Insert menu 

(5) None of the above 
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68. The ALU performs ..........  operations. 
(1) logarithm-based 

(2) ASC 

(3) algorithm-based 

(4) arithmetic 

(5) None of the above 

 

69. Excel is a program that is used to prepare a 

(1) Database 

(2) Text Document 
(3) Spreadsheet 
(4) Slide Presentation 

(5) None of the above 
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UNIT 4  

 

1. Which of the following is a par t of the Cent r a l Process ing Un i t?  

a. Printer 

b. Key board  c. Mouse 
d. Arithmetic & Logic unit 

e. None of these 

 

2. CAD stands for 

a. Computer aided design 

b. Computer algorithm for design 

c. Computer application in design d. All of the above  

e. None of these 

 

3. Which of the following printer cannot print graphics?  

a. Ink-jet 

b. Da i s y Wheel c. Laser 

d. Dot-matrix 

e. None of these 

 

4. A program written in machine language is called? 

a. A s semb le r  

b. Object 
c. Computer  

d. Mach i ne  

e. None of these 

 

5. The father of Modern Computer is 

a. Charles Babbage  

b. Von-nuumann  

c. Danies Ritchel 
d. Blaise Pascal 
e. None of these 

 

6. The Word FTP stands for 

a. File Translate Protocol 
b. File Transit Protocol 
c. File Transfer protocol 
d. file typing protocol 
e. None of these 

 

7. The lowest form of Computer language is called 

a. BASIC 

b. FORTRAN 

c. Mach i ne Language  

d. COBOL 
e. None of these 
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8. Best Quality graphics is produced by 

a. Do t Matix 

b. Laser Printer 

c. Inkjet Printer 

d. Plotter 

e. None of these 

 

9. Memory which forgets everyth ing when you
 switch off the power is know
n as 

a. Corrupted 

b. Volatile 

c. Non-Volatile 

d. Non-Corrupted 

e.None of these 

 

10.The linking of computers wi t h a communication system is c
alled 

a. Ne two rk i n g  

b. Pairing 

c. Interlocking 

d. Assemb l i ng  

e. Sharing 

 

11.The 16 bit M i c r o p r o c e s s o r means that it has  

a. 16 address lines 

b. 16 Buses  

c. 16 Data lines 

d. 16 routes 

e. None of these 

 

12. Data going into the computer is called 

a. Output 
b. algorithm 

c. Input 

d. Calculations 

e. flow chart 

 

13. Which of the following refers to a small, single-site
 network?  

a. LAN 

b. DSL 
c. RAM 

d. USB 
e. CPU 

 

14. Microsoft Office is 

a. Shareware 

b.Public domain software 

c. Open-sourse software 

d. A vertical market application 

e. An application suite 
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15. How many options does a BINARY choice offer 

a. None of these 

b. One 

c. Two 

d. it depends on the amount of memory on
 the computer 

e. It depends on the speed of the computer‘s processor 

 

16. A collection of program that controls how your computer syste
m  runs and 

processes information is called 

a. Operating System  

b. Computer  

c. Office 

d. Compi l e r  

e. Interpreter 

 

17. Computer connected to a LAN (Local Area Network) can  

a. run faster 

b. go on line 

c. share information and /or share peripheral equ
ipment 

d. E-mail 
e. None of these 

 

18. Information travels between components on the mother board th
rough  

a. Flash memory 

b. CMOS 
c. Bays  

d. Buses  

e. Peripherals 

 

19. How are data organized in a spreadsheet?  

a. Lines & spaces 

b. Layers & Planes 

c. Height & Wi d t h  

d. Rows & Columns  

e. None 

 

20. The blinking symbol on the computer screen is called the 

a. mouse 

b. logo 

c. hand  

d. palm  

e. cursor 

 

21. A fault in a computer program which prevents it from working  corr
ectly is 

known as 

a.B  oot 

b Bug 

c Biff 
d. Strap e. None of these 
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22. A self replicating program, similar to a virus which was taken  f

rom a 1970s  

science fiction novel by John
 Bruner entitled the Shockwave Rider is 

a. Bug 

b. V i ce  

c. Lice 

d. Worm 

e. None of these 

23. A states. is a bi-stable electronic circuit that has  

a. Multivibrator 
b. Flip-flop 

c. Log ic gates 

d. laten 

e. None of these 

 

24. Unwanted repetitious messages, such as unsolicited bulk e-mail is kno
wn 

as 

a. Spam 

b. Trash 

c. Calibri 
d. Courier 
e. None of these 

 

25.DOS stands for 

a. D i sk Operating System  

b. D i sk  operating session 

c. Digital Operating System  

d. Digital Open system 

e. None of these 

 

26. Who is the chief of Miocrosoft 
a. Babbage  

b. Bill Gates 
c. Bill Clinton d. Bush  

e. None of these 

 

27. Which of the following are input devices. 

a. Keyboard b. Mouse 

c. Card reader d. Scanner 

e. All of these 

 

28. Examples of output devices are  

a. Screen 

b. Printer 

c. Speaker 

d. All of these 

e. None of these 
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29. Which of the following is also known as brain of computer  

a. Control unit 

b. Central Processing unit 

c. Arithmetic and language unit 

d. Monitor 
e. None of these 

 

30. IBM stands for 

a. Internal Business Management  
b. International Business Management  
c. International Business Ma c h i n e s  

d. Internal Business Ma c h i n e s  e. None of these 

31.
 translates and executes program at run time li
ne by line 

a. Compi l e r  

b. Interpreter c. Linker 

d. Loader  

e. None of these 

 

32. is an OOP principle 

a. Structured programming  

b. Procedural programming  

c. Inheritance 

d. Linking 

e. None of these 

 

33.COBOLis wide ly  used  in application s 

a. Commercia l  
b. Scientific 

c. Space  

d. Mathematical 
e. None of these 

 

34. RAM stands for 

a. Random origin money 

b. Random only memory 
c. Read only memory 
d. Random access memory 

e. None of these 

 

35. 1 By te = ? 

a. 8 bits 

b. 4 bits  

c. 2 bits 
d. 9 bits 
e. None of the above 
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36. SMPS stands for 

a. Switched mode Power Supply 

b. Start mode power supply 

c. Store mode power supply 

d. Single mode power supply 

e. None of these 

 

37. The device used to carry digital data on analog lines is calle
d as 

a. Modem 

b. Multiplexer 
c. Modulator 
d. Demodu l a t o r  

e. None of these 

 

38. VDU is also called 

a. Screen 

b. Monitor 
c. Both 1 & 2 

d. printer 

e. None of these 

 

39. BIOS stands for 

a. Basic Input Output system 

b. Binary Input output system 

c. Basic Input Off system 

d. all the above  

e. None of these 

 

40. Father of ‗C‘ programming language  

a. Denn i s Ritchie 

b. Prof Jhon Kemeny c. Thomas Kurtz 

d. Bill Gates 
e. None of these 

 

ANSWERS 
------------------------------------------------------------------------------------------------------------ 
 

1. (d) 2. (a) 3. (b) 4. (a) 5. (a) 6. (c) 7. (c) 8. (
d) 

9. (b) 10. (a)11. (c) 12. (c) 13. (a) 14. (e) 15. (c) 

16. (a) 17. (c) 18. (c) 19. (d) 20. (e)21. (b) 22. (d
) 

23. (b) 24. (a) 25. (a) 26. (b) 27. (e) 28. (d) 29. (b
) 

30. (c) 31. (b) 32. (c) 33. (a) 34. (d) 35. (a) 

36. (a) 37. (a) 38. (c) 39. (a) 40. (a) 
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UNIT 5 

 

1.The instructions that tell a computer how to carry out the processing tasks are referred to as computer 
......... 
1) programs 
2) processors 
3) input devices 
4) memory modules 
5) None of these 

 

2.An area of a computer that temporarily holds data waiting to be processed is......... 
1) CPU 

2) Memory 

3) Storage 

4) File 

5) None of these 

 

3.To select or unselect one word to the right 
1) CTRL + SHIFT 

2) CTRL + SHIFT + UP Arrow 

3) CTRL + SHIFT + Down Arrow 

4) CTRL + SHIFT + Right Arrow 

5) None of these 

 

4.To maximize or restore a selected window 

1) CTRL + F7 

2) CTRL + F10 

3) CTRL + F8 

4) CTRL + F9 

5) None of these 

 

5.To Copy a picture of the selected window to the clipboard 

1) ALT + TAB 

2) Ctrl + TAB 

3) ALT + Print Screen 

4) Both (1) and (2) 
5) None of these 

 

6..........  is the key to close a selected drop - down list; cancel a comm-and and close a dialog box. 
1) TAB 

2) SHIFT 

3) ESC 

4) F10 

5) None of these 
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7.........  is the key we use to run the selected command. 
1) SHIFT 

2) TAB 

3) ENTER 

4) CTRL 

5) None of these 

 

8............  is the functional key to display save-as box. 
1) F5 

2) F6 

3) F9 

4) F12 

5) None of these 

 

9............  is the combination of keys to switch between the last four places that you have edited 

1) ALT + CTRL + Z 

2) ALT + CTRL + Y 

3) ALT + TAB + Z 

4) ALT + SHIFT + Z 

5) None of these 

 

10............  is the Keyboard shortcut key to insert auto sum 

1) ALT 

2) ALT= 

3) ALT+ 

4) ALT– 
5) ALT+CTRL 

 

11.Data becomes ................  when it is presented in a format that people can understand and use 

1) processed 

2) graphs 
3) information 

4) presentation 

5) None of these 

 

12.The term .............  designates equipment that might be added to a computer system to enhance its 
functionality. 
1) digital device 

2) system add-on 

3) disk pack 

4) peripheral device 

5) None of these 

 

13.A ............  is a microprocessor - based computing device. 
1) personal computer 
2) mainframe 

3) workstation 

4) server 
5) None of these 

 

NextDayJob.org Page 28



Fb.com/NextDayJob  

 

 

14.RAM can be thought of as the .........  for the computer's processor 
1) factory 

2) operating room 

3) waiting room 

4) planning room 

5) None of these 

 

15.Which of the following are the functions of a operating system 

1) Allocates resources 
2) Monitors Activities 
3) Manages disks and files 
4) All of the above 

5) Only 1 and 2 

 

16.To move a copy of file from one computer to another over a communication channel is called ? 
1) File transfer 
2) File encryption 

3) File modification 

4) File copying 

5) None of these 

 

17.The primary function of the ............  is to set up the hardware and load and start an operating system 

1) System Programs 
2) BIOS 

3) CP 

4) Memory 

5) None of these 

 

18.What kind of memory is both static and non - volatile ? 
1) RAM 

2) ROM 

3) BIOS 

4) CACHE 

5) None of these 

 

19..........  is computer software designed to operate the computer hardware and to provide platform for 
running application software 

1) Application software 

2) System software 

3) Software 

4) Operating system 

5) None of these 

 

20.The .........  is the amount of data that a storage device can move from the storage medium to the 

Computer per second 

1) data migration rate 2) data digitizing rate 

3) data transfer rate 4) data access rate 

5) None of these 

 

NextDayJob.org Page 29



Fb.com/NextDayJob  

 

 

21.A device, which is not connected to CPU, is called as ....... 
1) land-line device 

2) On-line device 

3) Off-line device 

4) Device 

5) None of the above 

 

22.What is the other name for programmed chip? 
1) RAM 

2) ROM 

3) LSIC 

4) PROM 

5) None of these 

 

23.On-line real time systems become popular in ...........  generation 

1) First Generation 

2) Second Generation 

3) Third Generation 

4) Fourth Generation 

5) None of these 

 

24.You use a(n) ....., such as a keyboard or mouse, to input information 

1) output device 

2) input device 

3) storage device 

4) processing device 

5) None of these 

 

25............  is the ability of a device to "jump" directly to the requested data 

1) Sequential access 
2) Random access 
3) Quick access 
4) All of the above 

5) None of these 

 

26............  provides process and memory management services that allow two or more tasks, jobs, or 
programs to run simultaneously 

1) Multitasking 

2) Multithreading 

3) Multiprocessing 

4) Multicoputing 

5) None of these 

 

27.The task of performing operations like arithmetic and logical operations is called ...... 
1) Processing 

2) Storing 

3) Editing 

4) Sorting 5) None of these 
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28.The ALU and Control Unit jointly known as 
1) RAM 

2) ROM 

3) CPU 

4) PC 

5) None of these 

 

29. RAM is an example of 
1) Secondary memory 

2) Primary memory 

3) Main memory 

4) Both (1) and (2) 
5) None of these 

 

30.Magnetic disk is an example of 
1) Secondary memory 

2) Primary memory 

3) Main memory 

4) Both (1) and (2) 
5) None of these 

 

31. Which one of the following is NOT a computer language / 

1) MS-Excel 
2) BASIC 

3) COBOL 

4) C++ 

5) None of these 

 

32.Each memory cell has a unique number, assigned to it is called as the......  of the cell 
1) Address 
2) Register 
3) Number 
4) Path 

5) None of these 

 

33.RAM is also called as 
1) Read / Write Memory 

2) Long Memory 

3) Permanent Memory 

4) Primary Memory 

5) None of these 

 

34. ............  Store data or information temporarily and pass it on as directed by the control unit 
1) Address 
2) Register 
3) Number 
4) Memory 

5) None of these 
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35.Select the Odd one 

1) Operating system 

2) Interpreter 
3) Compiler 
4) Assembler 
5) None of these 

 

36.A ............  is an additional set of commands that the computer displays after you make a selection 

from the main menu 

1) dialog box 

2) submenu 

3) menu selection 

4) All of the above 

5) None of these 

 

37.COBOL is an acronym for ............. 
1) Common Business Oriented Language 

2) Computer Business Oriented Language 

3) Common Business Operated Language 

4) Common Business Organized Language 

5) None of these 

 

38.All of the following are examples of real security and privacy risks EXCEPT 

1) hackers 
2) Spam 

3) viruses 
4) identity theft 
5) None of these 

 

39.Which of the following is NOT one of the four major data processing functions of a computer? 
1) gathering data 

2) processing data into information 

3) analyzing the data or information 

4) storing the data or information 

5) None of these 

 

40.All of the following are examples of storage devices EXCEPT : 
1) hard disk drives 
2) printers 
3) floppy disk drives 
4) CD drives 
5) Pen drives 
 

41.The CPU and memory are located on the : 
1) expansion board 

2) motherboard 

3) storage device 

4) output device 

5) display board 
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42..............  is the science that attempts to produce machines that display the same type of intelligence 

that humans do 

1) Nanoscience 

2) Nanotechnology 

3) Simulation 

4) Artificial intelligence (Al) 
5) None of these 

 

43.Servers are computers that provide resources to other computers connected to a : 
1) networked 

2) mainframe 

3) supercomputer 
4) client 
5) internet 
 

44.When creating a computer program, the .........  designs the structure of the program 

1) End user 
2) System Analyst 
3) Programmer 
4) All of the above 

5) None of these 

 

45.A computer program that converts an entire program into machine language at one time is called a/ an 

1) interpreter 
2) simulator 
3) characters 
4) numbers 
5) None of these 

 

46.Computers process data into information by working exclusively with : 
1) multimedia 

2) words 
3) characters 
4) numbers 
5) None of these 

 

47.The difference between people with access to computers and the Internet and those without this access is 
known as the : 
1) digital divide 

2) Internet divide 

3) Web divide 

4) broadband divide 

5) None of these 

 

48. Computers manipulate data in many ways, and this manipulation is called...... 
1) upgrading 

2) processing 

3) batching 

4) utilizing 5) None of these 
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49.The ability to recover and read deleted or damaged files from a criminal's computer is an example of a law 

enforcement speciality called: 
1) robotics 
2) simulation 

3) computer forensics 
4) animation 

5) None of these 

 

 

50.Where does most data go first with in a computer memory hierarchy ? 
1) RAM 

2) ROM 

3) BIOS 

4) CACHE 

5) None of these 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

34) 2 35) 1 36) 1 37) 1 38) 2 
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UNIT 6 

 

1. Which command divides the surface of the blank disk into sectors and assign a unique 

address to each one 

1) Ver 
2) Format 
3) Fat 
4) Check disk 

5) None of these 

 

2. If you need to duplicate the entire disk, which command will you use? 
1) Copy 

2) Disk copy 

3) Chkdsk 

4) Format 
5) None of these 

 

3. A............  sometimes called a boot sector virus, executes when a computer boots up 

because it resides in the boot sector of a floppy disk or the master boot record of a hard disk 

1) System virus 
2) Trojan horse virus 
3) File virus 
4) Macro virus 
5) None of these 

 

4. A result of a computer virus cannot lead to... 
1) Disk Crash 

2) Mother Board Crash 

3) Corruption o f program 

4) Deletion of files 
5) None of these 

 

5. Every computer connected to an intranet or extranet must have a distinct... 
1) Firewall 
2) Proxy server 
3) IP address 
4) Domain name 

5) None of these 

 

6. Programming language built into user programs such as Word and Excel are known as... 
1) 4GLs 
2) Macro languages 
3) object-oriented languages 
4) Visual programming languages 
5) None of these 
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7. Firewalls are used to protect against... 
1) Unauthorized Attacks 
2) Virus Attacks 
3) Data Driven Attacks 
4) Fire Attacks 
5) None of these 

 

8. Which of the following extensions suggest that the file is a backup copy? 
1) Bak 

2) Bas 
3) Com 

4) Txt 
5) None of these 

 

9. Computer programs are written in a high - level programming language; however, the 

human readable version of a program is called... 
1) Cache 

2) Instruction set 
3) Source code 

4) Word size 

5) None of these 

 

10. The software tools that enable a user to interact with a computer for specific purposes are 

known as... 
1) Hardware 

2) Networked Software 

3) Shareware 

4) Applications 
5) None of these 

 

11.............. processing is used when a large mail-order company accumulates orders and 

processes them together in one large set 
1) Batch 

2) Online 

3) Real-time 

4) Group 

5) None of these 

 

12. When a file contains instructions that can be carried out by the computer, it is often 

called a (n) ...  file 

1) Data 

2) Information 

3) Executable 

4) Application 

5) None of these 

 

13. A complier translates a program written in a high - level language into... 
1) Machine language 2) An algorithm 

3) A debugged program 4) Java 5) None of these 
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14. A set of step - by - step procedures for accomplishing a task is known as a (n)... 
1) Algorithm 

2) Hardware program 

3) Software bug 

4) Firmware program 

5) None of these 

 

15. A complete electronic circuit with transistors and other electronic components on a small 
silicon chip is called a (n)... 
1) Workstation 

2) CPU 

3) Magnetic disk 

4) Integrated circuit 
5) None of these 

 

16. A saved document is referred to as a... 
1) File 

2) Word 

3) Folder 
4) Project 
5) None of these 

 

17. What is output? 
1) What the processor takes from the user 
2) What the user gives to the processor 
3) What the processor gets from the user 
4) What the processor gives to the user 
5) None of these 

 

18. When you turn on the computer, the boot routine will perform this test... 
1) RAM test 
2) Disk drive test 
3) Memory test 
4) Power - on self-test 
5) None of these 

 

19. Which of the following storage media provides sequential access only? 
1) Floppy disk 

2) Magnetic disk 

3) Magnetic tape 

4) Optical disk 

5) None of these 

 

20. In word processing, an efficient way to move the 3rd paragraph to place it after 
the 5th paragraph is... 
1) Copy and paste 2) Copy, cut and paste 

3) Cut, copy and paste 4) Cut and paste 

5) None of these 
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21. Hardware includes......... 
1) All devices used to input data into a computer 
2) Sets of instructions that a computer runs or executes 
3) The computer and all the devices connected to it that are used to input and output data 

4) All devices involved in processing information including the central processing unit, memory 

and storage 

5) None of these 

 

22. The quickest and easiest way in Word, to locate a particular word or phrase in a document 
is to use the ...  command 

1) Replace 

2) Find 

3) Lookup 

4) Search 

5) None of these 

 

23. The term 'user interface' refers to........... 
1) What the user sees on the screen and how they can interact with it 
2) How the operating system responds to user commands 
3) The means by which the user interacts with the peripheral devices on the computer 
4) The monitor that is available for the computer 
5) None of these 

 

24. For creating a document, you use... command at File Menu. 
1) Open 

2) Close 

3) New 

4) Save 

5) None of these 

 

25. The.............  Becomes different shapes depending on the task you are performing 

1) Active tab 

2) Insertion point 
3) Mouse pointer 
4) Ribbon 

5) None of these 

 

26. Specilizd programs that assist users in locating information on the Web are called.... 
1) Information engines 
2) Search engines 
3) Web browsers 
4) Resource locators 
5) None of these 

 

27. The background of any Word document... 
1) Is always white colour 
2) Is the colour you presect under the Options menu 

3) Is always the same for the entire document 
4) Can have any colour you choose 5) None of these 
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28.Correcting errors in a program is referred to as ... 
1) Debugging 

2) Bugging 

3) Rectifying 

4) Modifying 

5) None of these 

 

29.Any letter, number, or symbol found on the keyboard that you could type into the computer 
.......... 
1) Output 
2) Character 
3) Type 

4) Print 
5) Font 
 

30.A symbol or question on the screen that prompts you to take action and tell the computer 
what to do next ... 
1) Scanner 
2) Questionnaire 

3) Prompt and dialog box 

4) Information seeker 
5) None of these 

 

31.Commands at the top of a screen such as FILE-EDIT-FONT-TOOLS to operate and change 

things within programs ... 
1) Menu bar 
2) Tool bar 
3) User friendly 

4) Word processor 
5) None of these 

 

32.The primary device that a computer uses to store information ... 
1) Monitor 
2) Memory 

3) Disk 

4) Hard drive 

5) None of these 

 

33.A file extension is separated from the main file name with a(n)..., but no spaces 
1) Question nark 

2) Exclamation mark 

3) Underscore 

4) Period 

5) None of these 
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34.Application software is designed to accomplish ... 
1) Real -world tasks 
2) computer-centric tasks 
3) Gaming tasks 
4) Operating system tasks 
5) None of these 

 

35.A ...  is a device that not only provides surge protection, but also furnishes your computer 
with battery backup power during a power outage 

1) Surge strip 

2) USB 

3) UPS 

4) Battery strip 

5) None of these 

 

36.The term .............  designates equipment that might be added to a computer system to 

enhance, its functionality 

1) Digital device 

2) System add-on 

3) Disk pack 

4) Peripheral device 

5) None of these 

 

37..........  this is the act of copying or downloading a program from a network and making 

multiple copies of it. 
1) Network piracy 

2) Plagiarism 

3) Software piracy 

4) Site-license piracy 

5) None of these 

 

38.When installing ..., the user must copy and usually decompressprogram files from a CDROM 

or other medium to the hard disk 

1) Programming software 

2) System hardware 

3) Applications hardware 

4) Applications software 

5) None of these 

 

39.Which one of the following would be considered as a way that a computer virus can enter a 

computer system ? 
1) Opening an application previously installed on the computer 
2) Borrowed an illegal copy of software 

3) Viewing a website without causing any additional transactions 
4) Running antivirus programs 
5) None of these 
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40.Programs such as Mozilla Firefox that serve as navigable windows into the Web are called 

.......... 
1) Hypertext 
2) Networks 
3) Internet 
4) Web browsers 
5) None of these 

 

41.What is the main difference between a mainframe and a super computer ? 
1) Super computer is much larger than mainframe computers 
2) Super computers are much smaller than mainframe computers 
3) Supercomputers are focused to execute few programs as fast as possible while mainframe 

uses its power to execute as many programs concurrently 

4) Supercomputers are focused to execute as many programs as possible while mainframe uses 
its power to execute few programs as fast as possible 

5) None of these 

 

42.What is the function of Recycle Bin ? 
1) Store deleted file 

2) Store temporary file 

3) Store corrupted file 

4) Store Document file 

5) None of these 

 

43.Which is the latest version of MS Office ? 
1) Office XP 

2) Windows XP 

3) Office 2007 

4) Office 2010 

5) None of these 

 

44.Which device cannot be shared in network ? 
1) Floppy 

2) Keyword 

3) Computer 
4) Printer 
5) None of these 

 

45.What is the purpose of query ? 
1) Input data 

2) Output data 

3) Sort & filter 
4) All of above 

5) None of these 

 

46.Which port doesn't exist in computer ? 
1) USB 2) Parallel 
3) Com1 / Com2 4) RAW 5) None of these 
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47.What is the name of excel files ? 
1) Workbook 

2) Worksheet 
3) Spreadsheet 
4) Spread book 

5) None of these 

 

48.Workgroup means 
1) Computers in network 

2) Individual user 
3) Individual computer 
4) All of the above 

5) None of these 

 

49.Synonym can be reviewed with 

1) Spelling and grammar 
2) Thesaurus 
3) Both 

4) Synonym viewer 
5) None of these 

 

50. Which command allows you to reduce fragments of file and optimize the performance of 
disk ? 
1) Scandisk 

2) Diskcomp 

3) Chkdsak 

4) Defrag 

5) None of these 
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UNIT 7 

 

1. Who is called as ‗‗Father of Computers‘‘? 
(A) Charles Babage 

(B) Blaise Pascal 
(C) Hollirth 

(D) All of these 

(E) None of these 

 

2. The first Digital Computer introduced, was named as : 
(A) Univac 

(B) Mark-I 
(C) Eniac 

(D) All of these 

(E) None of these 

 

3. How many generations, computer can be classified? 
(A) 4 

(B) 5 

(C) 3 

(D) 6 

(E) None of these 

 

4. First Generation Computers contain : 
(A) Transistors 
(B) Vacuum Tubes 
(C) LSI 
(D) VLSI 
(E) None of these 

 

5.  Generation Computers are made of : 
(A) Vacuum Tubes 
(B) Transistors 
(C) LSI 
(D) VLSI 
(E) None of these 

 

6. IV Generation Computers contain : 
(A) LSI 
(B) Vacuum Tubes 
(C) All Technology 

(D) Transistors 
(E) None of these 
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7. Vth Generation Computers are based on: 
(A) Artificial Intelligence 

(B) Programming Intelligence 

(C) System Knowledge 

(D) All of these 

(E) None of these 

 

8. Computers, combine both measuring and counting, are called : 
(A) Analog 

(B) Digital 
(C) Hybrid 

(D) All of these 

(E) None of these 

 

9. In world today, most of the computers are : 
(A) Digital 
(B) Hybrid 

(C) Analog 

(D) Complex 

(E) None of these 

 

10. In any computer installation, how many elements consists. 
(A) 2 

(B) 4 

(C) 3 

(D) 1 

(E) None of these 

 

11. Physical structure of computer is called : 
(A) Software 

(B) Hardware 

(C) Human ware 

(D) All of these 

(E) None of these 

 

12. A computer can perform, which of the following tasks? 
(A) Computation 

(B) Communication 

(C) Processing 

(D) All of these 

(E) None of these 

 

13. CPU stands for : 
(A) Computer Processing Unit 
(B) Central Processing Unit 
(C) Both (A) & (B) 
(D) Communication Processing Unit 
(E) None of these 
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14. In which type of computer, data are represented as discrete signals. 
(A) Analog computer 
(B) Digital computer 
(C) both 

(D) Digilog Computer 
(E) None of these 

 

15. Which of the following is available in the form of a PC now? 
(A) Mainframe 

(B) Microcomputer 
(C) Minicomputer 
(D) Both (B) & (C) 
(E) None of these 

 

16. PARAM is an example of: (A) Super computer 
(B) PC 

(C) Laptop 

(D) PDA 

(E) None of these 

 

17. Who developed the ‗analytical engine‘? 
(A) Jacquard loom 

(B) Charles Babbage 

(C) Shannon 

(D) IBM 

(E) None of these 

 

18. ENIAC stands for : 
(A) Electrical Numerical Integrator and Calculator 
(B) Electronic Numerical Integrator and Computer 
(C) Electronic Numerical Integrator and Calculator 
(D) Electronic Number Integrator and Calculator 
(E) None of these 

 

19. First Generation of computer was based on which technology? 
(A) Transistor 
(B) Vacuum Tube 

(C) LSI 
(D) VLSI 
(E) None of these 

 

20. Microprocessor was introduced in which generation of computer? 
(A) Second Generation 

(B) Fourth Generation 

(C) Both (A) & (B) 
(D) Third Generation 

(E) All of the above 
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21. GUI stands for : 
(A) Graphical User Interface 

(B) Graph Use Interface 

(C) Graphical Universal Interface (D) None of these 

 

22. The time taken by CPU to retrieve and interpret the instruction to be executed is called 

as: 
(A) Instruction cycle 

(B) Fetch cycle 

(C) Both (A) & (B) 
(D) All of these 

(E) None of these 

 

23. Which of the following is responsible for all types of calculations? 
(A) ALU 

(B) Control Unit 
(C) Registers 
(D) BUS 

(E) None of these 

 

24. Internal memory in a CPU is nothing but : 
(A) A set of registers 
(B) A set of ALU 

(C) Microprocessor 
(D) BUS 

(E) None of these 

 

 

25. Which of the following is permanent memory? 
(A) SRAM 

(B) DRAM (C) ROM 

(D) All of these 

(E) None of these 
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UNIT 8 

 

1. In a survey of more than 500 companies and government agencies, percent detected 

computer security breaches. 
A. 20 

B. 75 

C. 85 

D. 99 

Answer: C 

 

2. The survey showed that these businesses lost more than due to security breaches. 
 

A. $100,000 each 

B. $377 million 

C. five employees each 

D. $1 million 

Answer: B 

 

3. The typical computer criminal is a(n): 
A. young hacker. 
B. trusted employee with no criminal record. 
C. trusted employee with a long, but unknown criminal record. 
D. overseas young cracker. 
Answer: B 

 

4. The majority of computer crimes are committed by: 
A. hackers. 
B. insiders. 
C. overseas criminals. 
D. young teenage computer geniuses. 
Answer: B 

 

5. The common name for the crime of stealing passwords is: 
A. spooling. 
B. identity theft. 
C. spoofing. 
D. hacking. 
Answer: C Reference: Theft by Computer 
 

6. Collecting personal information and effectively posing as another individual is known as the crime 

of: 
A. spooling. 
B. identity theft. 
C. spoofing. 
D. hacking. 
Answer: B 

 

 

 

 

NextDayJob.org Page 47



Fb.com/NextDayJob  

 

7. Malicious software is known as: 
A. badware. 
B. malware. 
C. maliciousware. 
D. illegalware. 
Answer: B 

 

8. A program that performs a useful task while simultaneously allowing destructive acts is a: 
A. worm. 
B. Trojan horse. 
C. virus. 
D. macro virus. 
Answer: B Moderate 

 

9. An intentionally disruptive program that spreads from program to program or from disk to disk is 
known as a: 
A. Trojan horse. 
B. virus. 
C. time bomb. 
D. time-related bomb sequence. 
Answer: B 

 

10. In 1999, the Melissa virus was a widely publicized: 
A. e-mail virus. 
B. macro virus. 
C. Trojan horse. 
D. Time bomb. 
Answer: A 

 

11. What type of virus uses computer hosts to reproduce itself? 
A. Time bomb 

B. Worm 

C. Melissa virus 
D. Macro virus 
Answer: B 

 

12. The thing that eventually terminates a worm virus is a lack of: 
A. memory or disk space. 
B. time. 
C. CD drive space. 
D. CD-RW. 
Answer: A 

 

13. When a logic bomb is activated by a time-related event, it is known as a: 
A. time-related bomb sequence. 
B. virus. 
C. time bomb. 
D. Trojan horse. 
Answer: C 
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14. A logic bomb that was created to erupt on Michelangelo‘s birthday is an example of a: 
A. time-related bomb sequence. 
B. virus. 
C. time bomb. 
D. Trojan horse. 
Answer: C 

 

15. What is the name of an application program that gathers user information and sends it to 

someone through the Internet? 
A. A virus 
B. Spybot 
C. Logic bomb 

D. Security patch 

Answer: B 

 

16. Standardization of Microsoft programs and the Windows operating system has made the spread of 
viruses: 
A. more complicated. 
B. more difficult. 
C. easier. 
D. slower. 
Answer: C 

 

17. HTML viruses infect: 
A. your computer. 
B. a Web page in the HTML code. 
C. both a Web page and the computer that is viewing it. 
D. No 

Answer: B 

 

18. Software programs that close potential security breaches in an operating system are known as: 
A. security breach fixes. 
B. refresh patches. 
C. security repairs. 
D. security patches. 
Answer: D 

 

19. When customers of a Web site are unable to access it due to a bombardment of fake traffic, it is 
known as: 
A. a virus. 
B. a Trojan horse. 
C. cracking. 
D. a denial of service attack. 
Answer: D 
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20. is the measurement of things such as fingerprints and retinal scans used for security 

access. 
A. Biometrics B. Biomeasurement 
C. Computer security D. Smart weapon machinery 

Answer: A 

 

21. What is the most common tool used to restrict access to a computer system? 
A. User logins 
B. Passwords 
C. Computer keys 
D. Access-control software 

Answer: B 

 

22. The most common passwords in the U.S. or Britain include all EXCEPT: 
A. love. 
B. Fred. 
C. God. 
D. 123. 
Answer: D 

 

23. Hardware or software designed to guard against unauthorized access to a computer network is 
known as a(n): 
A. hacker-proof program. 
B. firewall. 
C. hacker-resistant server. 
D. encryption safe wall. 
Answer: B 

 

24. The scrambling of code is known as: 
A. encryption. 
B. a firewall. 
C. scrambling. 
D. password proofing. 
Answer: A 

 

25. If you want to secure a message, use a(n): 
A. cryptology source. 
B. encryption key. 
C. encryption software package. 
D. cryptosystem. 
Answer: D Reference: How It Works: 10.2 Cryptography 

 

26. To prevent the loss of data during power failures, use a(n): 
A. encryption program. 
B. surge protector. 
C. firewall. 
D. UPS. 
Answer: D 
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27. A(n) can shield electronic equipment from power spikes. 
A. encryption program 

B. surge protector 
C. firewall 
D. UPS 

Answer: B 

 

28. All of these are suggestions for safe computing EXCEPT: 
A. don‘t borrow disks from other people. 
B. open all e-mail messages but open them slowly. 
C. download shareware and freeware with caution. 
D. disinfect your system. 
Answer: B 

 

29. Freeware encrypts data. 
A. encryption 

B. firewall software 

C. PGP 

D. private and public keys 
Answer: C 

 

30. is defined as any crime completed through the use of computer technology. 
A. Computer forensics 
B. Computer crime 

C. Hacking 

D. Cracking 

Answer: B 

 

31. Most computer systems rely solely on for authentication. 
A. logins 
B. passwords 
C. encryption 

D. lock and key 

Answer: B 

 

32. Creating strong computer security to prevent computer crime usually simultaneously helps 
protect : 
A. privacy rights. 
B. personal ethics. 
C. the number of cookies downloaded to your personal computer. 
D. personal space. 
Answer: A 

 

33. Over was spent by businesses and government to repair problems in regard to Y2K. 
A. 20 million dollars 
B. 100 million dollars 
C. 1 billion dollars 
D. 100 billion dollars 
Answer: D 
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34. What is a complex system that takes on nearly complete responsibility for a task eliminating the 

need for people, verification, or decision-making? 
A. Autonomous system 

B. Missile defense auto-system 

C. Smart weapon 

D. Independent system 

Answer: D 

35. Security procedures can: 
A. will eliminate all computer security risk. 
B. reduce but not eliminate risks. 
C. are prohibitively expensive. 
D. are inaccessible for the average home user. 
Answer: B 

 

 

Fill in the Blank: 
 

36. The field of computer uses special software to scan hard drives of potential criminal 
suspects. 
Answer: forensics Reference: Online Outlaws: Computer Crime Difficulty: Challenging 

 

37. Computer   often goes unreported because businesses fear negative publicity. 
Answer: crime 

 

38. connections are the most frequent point of attack for Internet commerce. 
Answer: Internet 
 

39. is the most common form of computer crime. 
Answer: Theft 
 

40. A survey by eMarketer.com found that are the most often cited online fraud cases. 
Answer: online auctions Reference: Identity Theft 
 

41. Theft of computers is most common for PDAs and computers. 
Answer: notebook 

 

42. When you use a disk in several different computers within the same day, you are taking the 

chance of contracting a(n) . 
Answer: virus Reference: Viruses Difficulty: Easy 

 

43. A(n) attaches itself to documents that contain embedded programs that automate 

tasks. 
Answer: macro virus 
 

44. Both viruses and   use computer hosts to replicate. 
Answer: worms 
 

45. programs search for and eliminate viruses.Answer: Antivirus 
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46. A security patch is a software program that closes possible security breaches in the operating 

system. The cost to the consumer is . 
Answer: nothing or free 

 

47. was once the word used for malicious computer wizardry. 
Answer: Hackers or hacking 

 

48. refers to electronic trespassing or criminal hacking. 
Answer: Cracking 

 

49. DoS stands for   . 
Answer: denial of service 

 

50. DDoS stands for   . 
Answer: distributed denial of service 

 

51. hijack Web pages and redirect users to other sites. 
Answer: Webjackers 
 

52. software monitors and records computer transactions. 
Answer: Audit-control 
 

53. Each individual who uses a public key cryptosystem has keys. 
Answer: two Reference: How It Works: 10.2 Cryptography 

 

54. PGP stands for   . 
Answer: Pretty Good Privacy 

 

55. Mostoperating systems, including Windows XP, assign each user a unique . 
 

Answer: user identifier or user ID 

 

56. It should now be common knowledge that users should not open from e-mail recipients that 
the user does notknow. 
Answer: attachments 
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UNIT 9 

 

1. _ _ _ _ _ _ _ _ _ translates and executes program at run time line by line 

1) Compiler 
2) Interpreter 
3) Linker 
4) Loader 
5) None 

 

2. _ _ _ _ _ _ _ _ is an OOP principle 

1) Structured programming 

2) Procedural programming 

3) Inheritance 

4) Linking 

5) None 

 

3. COBOL is widely used in _ _ _ _ _ _ _ applications 

1) Commercial 
2) Scientific 

3) Space 

4) Mathematical 
5) None 

 

4. RAM stands for 

1) Random origin money 

2) Random only memory 

3) Read only memory 

4) Random access memory 

5) None 

 

5. 1 Byte = ? 

1) 8 bits 
2) 4 bits 
3) 2 bits 
4) 9 bits 
5) None 

 

6. SMPS stands for 

1) Switched mode power supply 

2) Start mode power supply 

3) Store mode power supply 

4) Single mode power supply 

5) None 

 

7. The device used to carry digital data on analog lines is called as 

1) Modem 

2) Multiplexer 
3) Modulator 
4) Demodulator 5) None 
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8. VDU is also called 

1) Screen 

2) Monitor 
3) Both 1 & 2 

4) printer 
5) None 

 

9. BIOS stands for 

1) Basic Input Output system 

2) Binary Input output system 

3) Basic Input Off system 

4) all the above 

5) None 

 

10. Father of ‘C’ programming language 

1) Dennis Ritchie 

2) Prof Jhon Kemeny 

3) Thomas Kurtz 4) Bill Gates 
5) None 

11. The 16 bit Microprocessor means that it has 

1) 16 address lines 
2) 16 Buses 
3) 16 Data lines 
4) 16 routes 
5) None 

 

12. Data going into the computer is called 

1) Output 
2) algorithm 

3) Input 
4) Calculations 
5) flow chart 
 

13. Which of the following refers to a small, single-site network? 

1) LAN 

2) DSL 

3) RAM 

4) USB 

5) CPU 

 

14. Microsoft Office is 

1) Shareware 

2)Public domain software 

3) Open-source software 

4) A vertical market application 

5) An application suite 
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15. How many options does a BINARY choice offer 

1) None 

2) One 

3) Two 

4) it depends on the amount of memory on the computer 
5) It depends on the speed of the computer‘s processor 
 

16. A collection of program that controls how your computer system runs and processes 

information is called 

1) Operating System 2) Computer 3) Office 4) Compiler 5) Interpreter 
 

17. Computer connected to a LAN (Local Area Network) can 

1) run faster 2) go on line 

3) share information and /or share peripheral equipment 
4) E-mail 5) None 

 

18. Information travels between components on the mother board through 

1) Flash memory 2) CMOS 3) Bays 4) Buses 5) Peripherals 
 

19. How are data organized in a spreadsheet? 

1) Lines & spaces 2) Layers & Planes 3) Height & Width 

4) Rows & Columns 5) None 

 

20. The blinking symbol on the computer screen is called the 

1) mouse 2) logo 3) hand 4) palm 5) cursor 
 

Ans:- 

01.2 06.1 11.3 16.1 

02.3 07.1 12.3 17.3 

03.1 08.3 13.1 18.3 

04.4 09.1 14.5 19.4 

05.1 10.1 15.3 20.5 
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UNIT 10 

 

1. When you are selecting a mouse for a particular computer system, what is the most important 
consideration? 
(1) The type of drivers that come with the mouse 

(2) The length of the mouse cord 

(3) The type of connector the mouse is equipped with 

(4) The number of buttons the mouse has 
(5) None of these 

Ans: (3) 
 

2. How is power supplied to a low-power USB device? 
(1) Through a power cable 

(2) From an external power supply 

(3) Directly from the computers power supply 

(4) Through the USB cable 

(5) None of these 

Ans: (4) 
 

3. All of the following are basic principles of net works, except — 

(1) each computer must have a network card 

(2) there must be communications media connecting the network hardware devices 
(3) there must be at least one connecting device 

(4) each computer must have software that supports the movement of information 

(5) None of these 

Ans: (2) 
 

4. The………….data mining technique derives rules from real-world case examples. 
(1) Rule discover 
(2) Signal processing 

(3) Neural nets 
(4) Case-based reasoning 

(5) None of these 

Ans: (3) 
 

5. …………….are used to identify a user who returns to a Website. 
(1) Cookies 
(2) Plug-ins 
(3) Scripts 
(4) ASPs 
(5) None of these 

Ans: (1) 
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UNIT 11 

 

1. Computer uses the ..........  number system to store data and perform calculations. 
(1) binary 

(2) octal 
(3) decimal 
(4) hexadecimal 
(5) None of these 

ANSWER: 1 

 

2. A disk's content that is recorded at the time of manufacture and that cannot be changed or erased 

by the user is- 
(1) Memory-only 

(2) Write-only 

(3) Once-only 

(4) Run-only 

(5) Read-only 

ANSWER: 5 

 

3. Which of the following can be used to select the entire document? 
(1) CTRL + A 

(2) ALT + F5 

(3) SHIFT + A 

(4) CTRL + K 

(5) CTRL + H 

ANSWER: 1 

 

4. ..........  are attempts by individuals to obtain confidential information from you by falsifying their 
identity. 
(1) Phishing 

(2) Computer viruses 
(3) Spyware scams 
(4) Viruses 
(5) None of the above 

ANSWER: 1 

 

5. Port number, port description, and number of ports ordered are examples of 
(1) control 
(2) output 
(3) processing 

(4) feedback 

(5) input 
ANSWER: 5 
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6. A Web site's main page is called its- 
(1) Home Page 

(2) Browser Page 

(3) Search Page 

(4) Bookmark 

(5) None of these 

ANSWER: 1 

 

7. The simultaneous processing of two or more programs by multiple processors is- 
(1) multiprogramming 

(2) multitasking 

(3) time-sharing 

(4) multiprocessing (5) None of these 

ANSWER: 1 

 

8. Codes consisting of lines of varying widths or lengths that are computer-readable are known as- 
(1) an ASC code 

(2) a magnetic tape 

(3) an OCR scanner 
(4) a bar code 

(5) None of these 

ANSWER: 4 

 

9. To instruct Word to fit the width of a column to the contents of a table automatically, click the 

.....  button and then point to AutoFit Contents. 
(1) Fit to Form 

(2) Format 
(3) Autosize 

(4) Contents 
(5) AutoFit 
ANSWER: 5 

 

10. Why is it unethical to share copyrighted files with your friends? 
(1) It is not unethical, because it is legal. 
(2) It is unethical because the files are being given for free. 
(3) Sharing copyrighted files without permission breaks copyright laws. 
(4) It is not unethical because the files are being given for free. 
(5) It is not unethical-anyone can access a computer 
ANSWER: 3 

 

11. Reusable optical storage will typically have the acronym- 
(1) CD 

(2) DVD 

(3) ROM 

(4) RW 

(5) ROS 

ANSWER: 4 
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12. The most common type of storage devices are- 
(1) persistent 
(2) optical 
(3) magnetic 

(4) flash 

(5) steel 
ANSWER: 2 

 

13. A device that connects to a network without the use of cables is said to be- 
(1) distributed 

(2) free 

(3) centralized 

(4) open source 

(5) None of these 

ANSWER:5 

 

14. A person who used his or her expertise to gain access to other people's computers to get 
information illegally or do damage is a- 
(1) hacker 
(2) analyst 
(3) instant messenger 
(4) programmer 
(5) spammer 
ANSWER: 1 

 

15. To access properties of an object, the mouse technique to use is- 
(1) dragging 

(2) dropping 

(3) right-clicking 

(4) shift-clicking 

(5) None of these 

ANSWER:3 

 

16. To change selected text to all capital letters, click the change case button, then click- (1) 
UPPERCASE 

(2) UPPER ALL 

(3) CAPS LOCK 

(4) Lock Upper 
(5) Large Size 

ANSWER: 1 

 

17. The basic unit of a worksheet into which you enter data in Excel is called a- 
(1) tab 

(2) cell 
(3) box 

(4) range 

(5) None of these 

ANSWER: 2 
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18. You can keep your personal files / folders in- 
(1) My folder 
(2) My Documents 
(3) My Files 
(4) My Text 
(5) None of these 

ANSWER: 2 

 

19. In Word you can force a page break- 
(1) By positioning your cursor at the appropriate place and pressing the F1 key 

(2) By positioning your cursor at the appropriate place and pressing Ctrl + Enter 
(3) By using the Insert/Section Break 

(4) By changing the font size of your document 
(5) None of these 

ANSWER: 2 

 

20. A DVD is an example of a(n)- 
(1) hard disk 

(2) optical disc 

(3) output device 

(4) solid-state storage device 

(5) None of these 

ANSWER:2 

 

21. The default view in Excel is .........  view. 
(1) Work 

(2) Auto 

(3) Normal 
(4) Roman 

(5) None of these 

ANSWER:3 

 

22. The process of transferring files from a computer on the Internet to your computer is called 

(1) downloading 

(2) uploading 

(3) FTP 

(4) JPEG 

(5) downsizing 

ANSWER: 1 

 

23. ..........  is the process of dividing the disk into tracks and sectors. 
(1) Tracking 

(2) Formatting 

(3) Crashing 

(4) Allotting 

(5) None of these 

ANSWER:2 
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24. Help Menu is available at which button? 
(1) End 

(2) Start 
(3) Turnoff 
(4) Restart 
(5) Reboot 
ANSWER:2 

 

25. The contents of ..........  are lost when the computer turns off. 
(1) storage 

(2) input 
(3) output 
(4) memory 

(5) None of these 

ANSWER: 5 

 

 

26. When you enter text in a cell in Excel, it also appears in which of the following? 
(1) Status bar 
(2) Formula bar 
(3) Row heading 

(4) Name box 

(5) None of these 

ANSWER:2 

 

27. Which elements of a Word document can be displayed in colour? 
(1) Only graphics 
(2) Only text 
(3) Only the first word of each line 

(4) All elements, but only if you have a colour printer 
(5) All elements 
 

28. A workbook is a collection of 
(1) Page Setup 

(2) Buttons 
(3) Diagrams 
(4) Charts 
(5) Worksheets 
ANSWER:5 

 

29. appear at the bottom of the Excel Window. 
(1) Sheet tabs 
(2) Name Box 

(3) Formula bar 
(4) Title bar 
(5) None of these 
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30. EPROM stands for 
(1) Erasable Programmable Read-Only Memory 

(2) Electronic Programmable Read-Only Memory 

(3) Enterprise Programmable Read-Only Memory 

(4) Extended Programmable Read-Only Memory 

(5) Electrical Programmable Read-Only Memory 

ANSWER: 1 

 

31. The technology that stores only the essential instructions on a microprocessor chip and thus 
enhances its speed is referred to as 
(1) CISC 

(2) RISC 

3) CD-ROM 

(4) Wi-Fi 
(5) MISC 

ANSWER: 2 

 

32. Which is not a basic function of a computer? 
(1) Store data 

(2)Accept input 
(3)Process data 

(4) Copy text 
(5) Accept and process data 

ANSWER: 4 

 

33. ASC is a coding system that provides 
(1) 256 different characters 
(2) 512 different characters 
(3) 1024 different characters 
(4) 128 different characters 
(5) 1000 different characters 
ANSWER: 4 

 

34. Which part of the computer is directly invoked in executing the instructions of the computer 
program? 
(1) The scanner 
(2) The main storage 

(3) The secondary storage 

(4) The printer 
(5) The processor 
ANSWER: 5 

 

35. In order to create column data in Word, you need to 

(1) tab consecutively until your cursor reaches the desired place 

(2) set tabs or use the Table menu 

(3) use Excel 
(4) press the space bar until your cursor reaches the desired place 

(5) None of these 

ANSWER: 5 
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36. Files are organised by storing them in 

(1) tables 
(2) databases 
(3) folders 
(4) graphs 
(5) diagrams 
ANSWER:3 

 

37. When a computer is switched on, the booting process performs 
(1) Integrity Test 
(2) Power-On Self-Test 
(3) Correct Functioning Test 
(4) Reliability Test 
(5) Shut-down 

ANSWER: 2 

 

38. In Word, the feature that automatically detects common errors is called 

(1) Autocorrect 
(2) Autograph 

(3) Spelling and Grammar 
(4) Go to 

(5) Thesaurus 
ANSWER:1 

 

39. A computer system that is old and perhaps not satisfactory is referred to as a(n) 
(1) Ancient system 

(2) Historical system 

(3) Age old system 

(4) Legacy system 

(5) Legal System 

ANSWER: 4 

 

40. Which of the following is not a binary number? 
(1) 001 

(2) 101 

(3) 202 

(4) 110 

(5) 011 

ANSWER:3 

 

41. Which of the following does not store data permanently? 
(1) ROM 

(2) RAM 

(3) Floppy Disk 

(4) Hard Disk 

(5) None of these 

ANSWER:2 
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42. Which of the following is the smallest storage? 
(1) Megabyte 

(2) Gigabyte 

(3) Kilobyte 

(4) Terabyte 

(5) None of these 

ANSWER:5 

 

43. Which menu enables the user to choose toolbars? 
(1) View 

(2) Format 
(3) Insert 
(4) Edit 
(5) Help 

ANSWER: 1 

 

44. By viewing the properties of the local hard disk of a computer, the user can find out 
(1) the amount of space that has been used up and the remaining free space on the disk. 
(2) the name of the user viewing the properties of the disk. 
(3) nothing useful to the user. 
(4) the number of programs available in the computer, 
(5) None of these 

ANSWER: 1 

 

45. Pre-defined and built-in formulas in Excel are known as 
(1) Autosheets 
(2) Diagrams 
(3) Charts 
(4) Tables 
(5) Functions 
ANSWER:5 

 

46. Which of the following contains permanent data and gets updated during the processing of 
transactions? 
(1) Operating System File 

(2) Transaction file 

(3) Software File 

(4) Master file 

(5) Any File 

ANSWER:4 

 

47. The keyboard shortcut to centralise the selected text in Word is 
(1) Ctrl + Esc 

(2) Ctrl + C 

(3) Alt + C 

(4) There is no keyboard shortcut for this operation 

(5) Ctrl + E 

ANSWER: 5 

 

 

NextDayJob.org Page 65



Fb.com/NextDayJob  

 

48. Which of the following helps to protect floppy disks from data getting accidentally erased? 
(1) Access notch 

(2) Write-protect notch 

(3) Entry notch 

(4) Input notch 

(5) None of these 

ANSWER:2 

 

49. A modem is connected to 

(1) a telephone line 

(2) a keyboard 

(3) a printer 
(4) a monitor 
(5) a scanner 
ANSWER:1 

 

50. Large transaction processing systems in automated organisations use 

(1) Online processing 

(2) Batch Processing 

(3) Once-a-day Processing 

(4) End-of-day processing 

(5) Once-a-week processing 

ANSWER:2 

 

51. The operation of combining two cells into a single cell in Excel is referred to as 
(1) join cells 
(2) merge cells 
(3) merge table 

(4) join table 

(5) None of these 

ANSWER:2 

 

52. Which of the following can be used to store a large number of files in a small amount of storage 

space? 
(1) File adjustment 
(2) File copying 

(3) File reading 

(4) File compatibility 

(5) File compression 

ANSWER:5 

 

53. In a computer, most processing takes place in 

(1) memory 

(2) RAM 

(3) motherboard 

(4) CPU 

(5) None of these 

ANSWER:4 
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54. Data is organized in a worksheet as 
(1) charts and diagrams 
(2) rows and columns 
(3) tables and boxes 
(4) graphs 
(5) None of the above 

ANSWER:2 

 

55. Which of the following is an example of a binary number? 
(1) 6AH1 

(2) 100101 

(3) 005 

(4) ABCD 

(5) 23456 

ANSWER:2 

 

56. Spell Check will find errors in which of the following? 
(1) Today is a rainy day 

(2) Today is a rainy a day 

 

(3) Is a rainy 

(4) Rainy today a day 

(5) None of the above 

ANSWER:5 

 

57. Which of the following is not a storage medium? 
(1) Hard disk 

(2) Flash drive 

(3) DVD 

(4) CD 

(5) Keyboard 

ANSWER:5 

 

58. In Excel, when the contents and attributes of a cell or range of cells have to be erased using the 

menu, the user must 
(1) select the Cells. choose Edit. and select Clear, then All 
(2) select the Cells. and click Delete on the keyboard 

(3) select the Cells. choose Tools. and select Clear. then Formats 
(4) select the Cells. choose Tools. and select Formula Audit. then Delete 

(5) None of the above 

ANSWER:1 

 

59. The computer abbreviation KB usually means 
(1) Key Block 

(2) Kernel Boot 
(3) Kilo Byte 

(4) Kit Bit 
(5) None of these 

ANSWER: 3 
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60. If an Excel Worksheet is to be linked for use in a PowerPoint presentation, the following should 

be clicked 

(1) Edit, Paste Special 
(2) Edit, Paste 

(3) Edit, Copy 

(4) File, Copy 

(5) None of the above 

ANSWER: 2 

 

61. RAM stands for 
(1) Random Access Memory 

(2) Ready Application Module 

(3) Read Access Memory 

(4) Remote Access Machine 

(5) None of the above 

ANSWER: 1 

 

62. Which of the following is the hardware and not the software? . 
(1) Excel 
(2) Printer driver 
(3) Operating system 

(4) Powerpoint 
(5) Control Unit 
ANSWER:5 

 

63. In Word, which menu would the user select to print a document? 
(1) Tools 
(2) File 

(3) View 

(4) Wind0Vob 

(5) None of these 

ANSWER: 2 

 

64. Which of the following is not true about computer files? 
(1) They are collections of data saved to a Storage medium 

(2) Every file has a filename 

(3) A file extension is established by the user to indicate the date it was created 

(4) Usually files contain data 

(5) None of the above 

ANSWER:5 

 

65. The common name for a modulator-demodulator is 
(1) modem 

(2) joiner 
(3) networker 
(4) connector 
(5) demod 

ANSWER: 1 
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66. What do you see when you click the right mouse button? 
(1) The same effect as the left click 

(2) A special menu 

(3) No effect 
(4) A mouse cannot be right clicked 

(5) Computer goes to sleep mode 

ANSWER:2 

 

67. In order to choose the font for a sentence in a Word document, 
(1) select Font in the Format menu 

(2) select Font in the Edit menu 

(3) select Font in the Tools menu 

(4) select Font in the Insert menu 

(5) None of the above 

ANSWER:1 

 

68. The ALU performs ..........  operations. 
(1) logarithm-based 

(2) ASC 

(3) algorithm-based 

(4) arithmetic 

(5) None of the above 

ANSWER:4 

 

69. Excel is a program that is used to prepare a 

(1) Database 

(2) Text Document 
(3) Spreadsheet 
(4) Slide Presentation 

(5) None of the above 

ANSWER:3 

 

70. ..........  consists of volatile chips that temporarily store data or instructions. 
(1) CPU 

(2) ROM 

(3)RMA 

(4) RAM 

(5) None of these 

ANSWER:4 

 

 

 

 

 

 

 

 

 

 

 

NextDayJob.org Page 69 



Fb.com/NextDayJob  

 

UNIT 12 

 

1. The Core Banking software used by our bank is called:- 
a. Pinnacle 

b. Finacle 

c. Flexcube 

d. Solaris 
e. None of the above 

Ans (C) 
 

2. The unique number given while opening the customer master is called 

a) Customer number 
b) Customer identification Number (Cust –ID) 
c) Account ID 

d) PAN No 

e) None of the above 

Ans (B) 
 

3. The Unique Customer Identification Number consists of digits. 
a) 12 numbers 
b) 2 alphabets and 6 digits 
c) 10 numbers 
d) 15 digits 
e) None of the above. 

Ans (C) 
 

4. The Customer master maintenance captures the following details of the customer. 
a) Occupation 

b) Residential address 
c) Date of Birth 

d) Introducer details 
e) All the above 

Ans (E) 

 

5. As per KYC norms the following details are to be compulsorily captured while opening new 

accounts. 
a) Identity proof 
b) Residence proof 
c) Employment details 
d) All the above 

e) a & b a b o v e 

Ans (B) 
 

6. The Alternate Banking Delivery Channels are :- 
a) E-banking 

b) Mobile banking 

c) ATM 

d) SMS banking 

e) All the above Ans (D) 
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7. In whichever screen, where Account number is there, Signature scanned will be displayed by 

pressing which key. 
a) Alt+A b) Alt+B c) Alt+C d) Alt+S e) Alt+P 

Ans (D) 
 

8. Hold Funds earmarked can be revoke (Delete) by Fast Path 

a) 1055 b) C H M3  1 c) CHM33 d) C H M3  5 e) N o n e of the above 

Ans (C) 
 

9. Menu for finding incomplete financial transactions in FCR? 
a) 4500 b) 4501 c) 4502 d) 4503 e) N o n e of the above 

Ans (D) 
 

10. Term deposits in FCR are auto renewed on the due date. This is happens 
a) Without Change in deposit account number 
b) New deposit account number is created 

c) Renewed at the existing period and scheme 

d) Only maturity date is changed 

e) Option ‗a‘ and ‗c‘ are true 

Ans (E) 

 

11. In CBS environment every branch and its extension counters as different Service outlets. The each 

office/branch will have separate DP code.For FCR & FCC DP code consists of- 
a) 4 D i g i t s & 3 C h a r a c t e r s 
b ) 4 digiths for both 

c) 4 digits & 4 Characters 
d) 3 digits for both 

e) None of the above 

Ans (A) 
 

12. Function key F8 is used for 
a) Accepting the input b) Going to next screen c) Committing 

d) To invoke the last used option e) None of these 

Ans (D) 
 

13. To move to the previous field while working in FCR which combination of keys can be used 

a) Ctrl+F b) Shift +Tab c) C t r l + Tab d) Ctrk + E e) Shift + F3 

Ans (B) 
 

14. The key combination populates the Mobile Number & PAN of customer in the screen where Account 
Number is entered: 
a) Control + B b) Alt+B c) Control + C 

d) Alt+C e) Control +A 

Ans (C) 
 

15. This Functional key should be used when the user wants to clear a field in FCC 

a) F7 b) F8 c) F1d) F11 e) F10 

Ans (A) 
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16. Details of cheques paid/unpaid can be found from the menu-? 
a) CHM35 b) C H M3  7 c) CHM32 

d) CHM39 e) C H M 3 3 

Ans (B) 
 

17. The menu for marking stop payment is ? 
a) CHM35 b) C H M3  7 c) CHM32 

d) CHM39 e) C H M 3 3 

Ans (A) 
 

18. External lien on KDR can be marked using the Fast Path ? 
a) TDM39 b) T DM 24 c) C H M 0 7 d) LNM34 e) A L L the above 

Ans (B) 
 

19. Our individual Customers can now self generate e-banking ID and Password provided their 
customer master is updated with the following. 
a) Mobile number and email address b) Email address only 

c) Mobile no, date of birth and email add 

d) Mobile number, date of birth, email add and free text-Y 

e) None of the above 

Ans (E) 

 

20. The customer has lost his ATM card. How can he hot list the ATM card for preventing misuse? 
a) Inform the card details at our Call center b) C o n t ac  t the branch for hot listing 

c) Both ‗a‘ or ‗b‘ 
d) None of the above e) S e n d a letter to the branch informing the loss of the card. 

Ans (C) 
 

21. The computers in all our branches are interconnected within the premises and this is called as 
a) LAN-Local Area Network 

b) WAN-Wide Area Network 

c) Peer Network 

d) Star Network 

e) None of the above 

Ans (A) 
 

22. Wherever networks are not possible, our bank has gone for satellite connections otherwise called 

as --- 
a) WINSAT 

b) VSAT 

c) SAT 

d) VAT 

e) TAT 

Ans (B) 
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23. The processing of loan proposal has been recently computerised and the package for it is 
a) SAFE- 
b) Lending Automation solutions (LAS) 
c) ALPS-Automated Lending Processing System 

d) Lead management solutions(LMS) 
e) None of the above 

Ans (C) 
 

24. Cheques lodged in inward clearing can be viewed by the branch using the menu ? 
a) ST639 b) ST038 c) ST6002 d) ST999 

e) None of the above 

Ans (A) 
 

25. To inquire on the status of a cheque entered in outward clearing , you can use the menu option . 
a) ST639 

b) ST038 

c) ST6001 

d) All the above 

e) None of the above 

Ans (B) 
 

26. Once a transaction is authorised, No modification is allowed. Whether the statement is true or 
false? 
a) True b) False 

c) Partially True 

d) Partially False 

e) None of the above 

Ans (A) 
 

27. ‖―Mouse  in a computer is ‗…………………‘ device 

a) Input 
b) Output 
c) Control 
d) Slow 

e) All the above 

Ans (A) 
 

28. ―SAFE‖ stands for 
a) Storage Accounting for Everyone 

b) Flexible Locker inventory System 

c) Inter linking with CBS-FCR with regard to Customer details and collection of Locker 
Rent through GEFU 

d) All of the above 

e) None of the above 

Ans (D) 
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29. ―Monitor‖ in a computer is ‗…………………‘device 

a) Show 

b) Output 
c) Input 
d) Control 
e) Any One of the above 

Ans (B) 
 

30. Canara Bank has an Anti-Virus solution from ‗…………………………….‘ Company 

a) Macafee 

b) Avira 

c) Symantec 

d) Norton 

e) Microsoft 
Ans (C) 
 

31. ‖―OS  in a computer stands for 
a) Open Source 

b) Opening System 

c) Operating System 

d) Optional System 

e) Operational Support 
Ans (C) 
 

32. ―Plastic Money‖ is referred to 

a) Credit Card 

b) Debit Card 

c) Gift Card 

d) ATM Card 

e) All the above 

Ans (E) 

 

33."Caps Lock‖ key in Key Board is used for 
a) Lock the key board 

b) Toggle key for lower/upper case of English Alphabet 
c) Capturing the print on the screen 

d) Control the locking system of computer 
e) All the above 

Ans (B) 
 

34.Account Operating Instructions in CBS can be viewed in any screen where account number is 
entered by opting Hot Keys- 
a) Alt+A,b)Alt+B,c)Alt+C,d)Ctrl+S,e)Alt+S 

Ans (E) 

 

35. ‖―………………….  Is an input device 

a) ROM 

b) RAM 

c) Keyboard d) Monitor e) Motherboard Ans (C) 
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36. ‗………………..‘ is not a storage device 

a) RAM 

b) Pen drive c) Floppy 

d) Hard disk 

e) Compact Disk 

Ans (A) 
 

37. In a branch, ‗UPS‘ is used to Supply Electric Power to 

a) Computers 
b) Room Heaters 
c) Vacuum Cleaner 
d) Air Conditioners 
e) All the above 

Ans (A) 
 

38. Computer data is stored in ‗………………….‘ 
a) Tonnes 
b) Milliseconds 
c) Bytes 
d) Litres 
e) Millimeters 

Ans (C) 
 

39. Computer data means 
a) Information about customers‘ accounts 
b) Information about transactions 
c) Information about customers‘ signatures 
d) All the above 

e) None of the above 

Ans (D) 
 

40.‖Software‖ means 
a) Soft Computer devices like cables etc. 
b) Programs used in computer 
c) Soft touch screen monitors 
d) Print outs taken on soft papers 
e) All the above 

Ans (B) 
 

41.‘CPU‘ is ‗………………..‘ of a computer 
a) Brain 

b) Face 

c) Eyes 
d) Stomach 

e) All the above 

Ans (A) 
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42. Computers should be used with ‗………………………….‘ Power supply 

a) A C 

b) D C 

c) M C 

d) W C 

e) All the above 

Ans (B) 
 

43. A Computer cannot work without 
a) Mouse 

b) Key Board 

c) Mother Board 

d) Pen Drive 

e) Hard disk 

Ans (C) 
 

44.‖USB‖ port in a computer is used to connect 
a) Pen Drive 

b) Mouse 

c) Key Board 

d) Hard Disk 

e) All the above 

Ans (E) 

 

45.‖Log Out‖ means 
a) Shut down the computer 
b) Come out from the package 

c) Switch off mains power supply to the computer d) Enter the ID and Password 

e) All the above 

Ans (B) 
 

46.‖VIRUS‖ is 
a) Malicious program to destroy computer data 

b) Computer program to play games on computer 
c) Very Intelligent, Resourceful and Useful System 

d) Computer device to download the softcopy of data e) Any one of the above 

Ans (A) 
 

47. ―Softcopy‖ means 
a) Print Out on a soft paper 
b) Print Out on a soft film 

c) Copy of data in program language 

d) Latest CD available in the market 
e) All the above 

Ans (C) 
 

 

 

 

 

NextDayJob.org Page 76 



Fb.com/NextDayJob  

 

48. ‗www‘ means 
a) World without wirus 
b) Worldwide wealth 

c) World Wide Web 

d) World with web 

e) World without Web 

Ans (C) 
 

49. A computer in network is identified by ‗…………………………‘ 
a) I P Address 
b) Place where it is kept 
c) Log in ID and Password of the user 
d) V Sat placed on the rooftop 

e) All the above 

Ans (A) 
 

50. To do banking transactions himself through computer, a customer must have 

a) Internet Banking ID and password 

b) Windows based Computer c) Internet connection 

d) Any one of the above e) All a,b & c 

Ans (E) 

 

51. Bank‘s call centre can handle customers‘ request in ‗……………..‘ languages 
a) 7 

b) 2 

c) 9 

d) 5 

e) 3 

Ans (A) 
 

52.SMS Banking facility allows a customer to 

a) Get transaction alerts on the mobile 

b) Get mini statement on mobile 

c) Get cheque paid/unpaid status on mobile 

d) Get loan overdue notice on mobile 

e) All the above 

Ans (E) 

 

53.RTGS/NEFT is used to do a 

a) Bank to bank transaction (Inter-Bank) 
b) Branch to Branch Transaction (Intra- Bank) 
c) Banks in India to Overseas Banks d) Any one of the above 

e) All the above 

Ans (A) 
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54. Minimum amount for funds transfer in ‗NEFT‘ is 
a) 1.00 lac 

b) 100 

c) 1000 

d) No limit 
e) 5000 

Ans (D) 
 

55. Minimum amount for funds transfer in ―RTGS‖ is 
a) 2.00 lac 

b) 50,000 

c) 5.00 lac 

d) 10.00 lac 

e) No Limit 
Ans (A) 
 

56. ‗Buy today, pay tomorrow‘ is possible by using 

a) Debit Card 

b) Credit Card 

c) Gift Card 

d) Greeting Card 

e) Any One of the above 

Ans (B) 
 

57.‘Interest free loan‘ for a limited time is available to customers while using 

a) Credit Card 

b) Debit Card 

c) E Card 

d) Gift Card 

e) All the above 

Ans (A) 
 

58. Ideally a customer must have one ‗……………………..‘ across the bank 

a) Account ID 

b) Customer ID 

c) CBS ID 

d) Place ID 

e) All the above 

Ans (B) 
 

59. ―Toll free‖ number means 
a) No Toll Tax 

b) No timing 

c) No Charges 
d) No Network 

e) All the above 

Ans (C) 
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60. Which is the easier, cheaper, quicker and secure way of transferring money to a customer of 
another bank? 
a) Demand Draft 
b) Multi City Cheque 

c) RTGS/NEFT 

d) Pay Order 
e) All the above 

Ans (C) 
 

61. Stuck in a traffic jam, how a customer can do a fund transaction 

a) Through SMS Banking 

b) Through Mobile Banking 

c) Visiting any nearby Bank 

d) All the above 

e) Any one of these 

Ans (B) 
 

62. As a precaution, FCR ‘Password‘ should be informed to 

a) Branch Head 

b) RCC 

c) Data Centre 

d) Family members 
e) No one 

Ans (E) 

 

63. Main gate of ―ATM‖ should be 

a) Closed at the close of branch hours 
b) Closed during 9.30 PM to 6.30 AM 

c) Never Closed 

d) Closed during replishment the Cash 

e) None of the above 

Ans (D) 
 

64.‖ATM‖ machine has ‗………………….‘ Cassettes 
a) Two 

b) Three 

c) Four 
d) One 

e) Five 

Ans (C) 
 

65. In a ATM if a customer fails to take cash, the cash goes to 

a) Bin from where it came 

b) Reject Bin 

c) Dropped on the ground 

d) Inside ATM case 

e) Any one of the above 

Ans (B) 
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66. Debit cards of Canara Bank are issued by 

a) VISA 

b) Master 
c) Both Visa and Master 
d) Infosys 
e) None of these 

Ans (C) 
 

67. Reward Points can be earned by using 

a) ATM card at ATMs 
b) Debit card for purchases 
c) Credit Card for purchases 
d) Gift Card for Purchases 
e) Any one of these 

Ans (C) 
 

68. We have ATMs of following companies 
a) N C R 

b) W I N C O R 

c) D I E B O L D 

d) a & c 

e) a b & c 

Ans (C) 
 

69. Credit card (Visa Card) used for purchases on 22.04.2012, what will be the due date for payment 
of bill 
a) 10.04.2012 

b) 20.04.2012 

c) 22.04.2012 

d) 10.05.2012 

e) 22.05.2012 

Ans (D) 
 

70. Bill for Credit Card (Master Card) for a month is generated on ‗………………..‘ date 

a) 20th of every month 

b) 1st day of next month 

c) Last day of the month 

d) Same day 

e) No idea 

Ans (C) 
 

71. Interest from the date of purchase till payment on due date for credit card bill is charged @ P A 

a) 24 % 

b) 18.25% 

c) 11.25% 

d) No Interest e) 10 % 

Ans (D) 
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72. To shut down a computer, 
a) Switch off the power supply directly 

b) Switch off the monitor 
c) Click on start button and then click on shut down 

d) Remove the power cable to CPU 

e) Any one of the above 

Ans (C) 
 

 

73. Which is the longest key on the key board? 
a) Space bar 
b) Enter key 

c) ‗0‘ key 

d) Function key 

e) Shift Key 

Ans (A) 
 

74. ‗ # ‗ is known as 
a) dash 

b) mash 

c) hash 

d) cash 

e) ash 

Ans (C) 
 

75. ‗Home‘ key in key board is used to 

a) go home 

b) go out 
c) go to beginning 

d) go to end 

e) All the above 

Ans (C) 
 

76. While typing, use of ―Shift‖ key with any alphabet 
a) Changes the case of alphabet 
b) Makes the alphabet bold 

c) Makes the alphabet underlined 

d) Makes the alphabet italicized 

e) All the above 

Ans (A) 
 

77. @ # ? * are known as 
a) junk characters 
b) sink characters 
c) special characters 
d) mild characters 
e) All the above 

Ans (C) 
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78. A strong password should have minimum ‗………….‘ Characters 
a) 8 

b) 6 

c) 10 

d) 2 

e) No limit 
Ans (A) 
 

79. Generally strong password should have only 

a) Alphabets 
b) Numerals 
c) Special Characters 
d) a & b 

e) a b& c 

Ans (D) 
 

80. ‗nEhA@2010‘ is a ‗…………………..‘ password 

a) weak 

b) Strong 

c) mild 

d) soft 
e) Harsh 

Ans (B) 
 

81. In Canara Bank, ‗D I T‘ stands for 
a) Department of Information Technology 

b) Department for Institutional Technology 

c) Department of Income Tax 

d) Department for Inventions in Technology 

e) Department for Information and Training 

Ans (A) 
 

82. With the help of Debit card, maximum ‗…………………….‘ Cash can be withdrawn per day from 

Canara Bank ATM. 
a) 10,000 

b) 40,000 

c) 20,000 

d) 25,000 

e) No Limit 
Ans (D) 
 

83. Which of the following can be used to withdraw cash from our ATM 

a) Gift Card 

b) Credit Card 

c) Greeting Card 

d) E Card 

e) All the above 

Ans (B) 
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84. The Intranet site of Canara bank is called as:- 
a) CANARANET 

b) CANNET 

c) NET BANKING 

d) CANMOBILE 

e) None of the above 

Ans (B) 
 

85. The Official web site of Canara Bank is: 
a ) www.canarabank.co.in 

b) www.canbank.co.in 

c) www.canarabank.com 

d) www.canbank.com 

e) None of the above 

Ans (C) 
 

86. The User-ID to login to Banks RTGS -STP consists of:- 
a) Staff number 
b) Staff number prefixed with Initials 
c) Staff number prefixed with Zero 

d) Staff number prefixed with R 

e) Staff number suffixed with zero 

Ans (C) 
 

87. DRC (Disaster Recovery Centre) of Canara Bank is situated at- 
a) DIT,Bangalore 

b)Chennai 
c) Delhi 
d)Hyderabad 

e)Mumbai 
Ans (E) 

 

88. Call centre of Canara Bank is established at------ and being maintained by----- 
a) DIT, Bangalore & Canara Bank 

b) DIT, Bangalore & CCSL (Canara Bank Computer Services Ltd) 
c)Spencer Tower M G Road Bangalore & Transaction wing 

d)DRC, Mumbai & IBM 

e) None of the above 

Ans (B) 
 

89. Which of the following cannot be used by a customer to do banking tractions himself-? 
a)Computer with Internet connection 

b) Mobile 

c) Canara bank call Centre 

d)ATM 

e) None of the above 

Ans (C) 
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90. Validity of Password in CBS (FCR & FCC) is 30 days System prompts to modify -----days in advance- 
a) 7 Days in FCR & 5 Days in FCC 

b) 5 days in FCR & 7 days in FCC 

c) 10 days in both FCR&FCC 

d) None of the above 

e) There are no such prompts available. 
Ans (B) 
 

91.In order to get PRR-33:Quarterly Report on LPD Accounts in CBS(FCR) LPD/Suits details are 

required to capture in Fast Path- 
a)BAM83, b) BAM74,c)CIM09,d)BAM59,e) None of the above 

Ans (D) 
 

92. AOD (Acknowledge of Debt) details in FCR to be captured to for getting PRR-12 from the system 

by opting Fast Path- 
a)CIM09,b)BAM83,c)BA020,d)BAM59,e) None of the above 

Ans (C) 
 

93. In tune with the Damodaran Committee recommendations on Customer Service in Banks our Bank 

has developed internet based Online Public Grievances Redressal System with the facility to track 

the status online by our customers/general public which is called as- 
a) OPGRS 

b) CPGRS (Canara Public Grievances Redressal System) 
c) OLTS 

d) HRMS 

e) None of the above 

Ans (B) 
 

94. USBs (Ultra Small Branches) can access CBS through Laptop over VPN (Virtual Private Network) 
using secured URL: 
a) www.canarabak.com 

b)www.canarabank.in 

c)www.canarabankesn.com 

d)www.canarabankcbs.com 

e) No such facility is available. 
Ans (C) 

95. For Login to USB (Ultra Small Branch) which one is not correct? 
a) Same FCR user ID and Password is required 

b) Separate Login ID and Password is required 

c) Template code 52 to be assigned to the deputing officer 
d) URL hhp://172.16.37.38/brn9999/ 

e) A separate user profile in CBS with template code 80 

Ans (A) 
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96. Canara Bank has introduced Online Loan Application & status Tracking System to enable public to 

submit online Loan applications by logging into Bank‘s website as per the recommendation of Mr. 
Damadodarn Committee. This is known as- 
 

a) ALPS (Automated Lending Processing System) 
b) LAPS (Lending Automated Processing System) 
c) OLTS (Online Loan Application &Tracking System) 
d)CRM(Customer Relationship Management) 
e) None of the above 

Ans (C) 
 

98. View option for status of Outward NEFT message in FCR is- 
a) PM11, b) PM09, c) PMS9, d) NB09,e) None 

Ans (B) 
 

 

99. At present which one of the facility is not available in Canara Bank‘s ATM-? 
 

a) Mobile Top up 

b) Registration of mobile for SMS alert 
c) IMPS (Interbank Mobile Payment Service) Funds transfer 
d) Direct Tax Payment 
e)Visa Money Transfer 
 

Ans (E) 

 

100. Which one is not relevant about MMID?- 
 

a) Stands for Mobile Money Identifier 
b) 7 digit number allotted by the customer‘s Bank 

c) For each account separate MMID is required 

d) MMID can be retrieved by sending SMS to 5607060 by typing in Capital letter: CANMMID 

e) Beneficiary must have Mobile Banking facility to get MMID from Bank. 
 

Ans(E) 
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UNIT 13 

 

1. Native Reports are 

a. Adhoc Report 

b. Batch Report 

c. Report generated from Production data or OLTP data. 

d. All the above. 

e. None of the above. 

Ans (D) 
 

2. Which one is not correct about Adhoc report 

a. Online Report 

b. Generated under FCR fast path 7775 

c. View/ print under 7778 

d. EOD/BOD Report 

e. Generated directly from production data base. 

Ans (D) 
 

3. Batch Reports are- 

a. Adhoc Report 

b. EOD/BOD Report 

c. Available under Business Objective 

d. Generated by FRS data base 

e. All the above 

Ans (B) 
 

4. Business Object (BO) reports are generated from 

a. FCR data base directly 

b. FCC data base directly 

c. Single Sign on Server 

d. Production Server 

e. Flex cube Report Server (FRS) data base 

Ans (E) 

 

5. Which one of the following Report is not a part of BO report 

a. Daily Report 

b. Consistency Check Report 

c. Balancing Report 

d. Balance Sheet Statement & Report 

e. Statement of a CASA account 

Ans (E) 
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6. Flex cube Corporate related reports can be access through 

a. FCC data base directly 

b. FCR data base 

c. From GL report server 

d. Business Object 

e. All the above. 

Ans (D) 
 

7. FRS published report can be accessed under URL 

a. http://172.16.42.70/ 

b. https://172.16.42.70/ 

c. http://172.16.142.70/ 

d. Any one of the above. 

e. None of the above. 

Ans (A) 

8. Mandatory Reports in CBS is framed based on which one of the following 

a. Business Aspects 

b. Daily/Periodic Requirement 

c. Administrative Requirement 

d. Audit Requirement 

e. All the above 

Ans (E) 

 

9. CBS branches/ offices are required to generate view/print and preserve the required/ 

mandatory report without fail because 

a. It is difficult to generate at future date. 

b. Archiving / purging of data from central server. 

c. Storage limitation 

d. None of the above. 

e. All the above. 

Ans (E) 

 

10. W.E.F 01.04.2012 R-Returns will be compiled through 

a. FETERS 

b. Extracting data from FCR/FCC 

c. Separate server installed at ID Mumbai 

d. Data from FDs 

e. None of the above 

Ans (B) 
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11. FETERS is 

a. Foreign Exchange Transaction Electronic Reporting System 

b. Used for R-Return compilation 

c. Discontinued w.e.f 01.04.2012 

d. All the above 

e. None of the above 

Ans (D) 
 

12. Regarding Daily slip preparation under CBS environment, which is not correct 

a. Waived in CBS environment 

b. It should be prepared user-wise duly initialed/ authenticated both by maker/checker 

and Authorizers 

c. User should write the A/Cs head along with GL No, Txn. sequence no. and clear 

narration 

d. Daily mandatory report should be generated for tallying 

e. Preserved safely in slip bundle 

Ans (A) 
 

13. Under CBS environment maximum cash withdrawal is permitted to 3rd party at HOST branch 

a. Any amount 

b. Not permitted 

c. `50000/- 
d. `100000 

e. `200000 

Ans (B) 
 

14. One of the CA party has got ` 10  Lakhs balance in his A/C. How much amount he can 

withdraw by self cheque in a  day from host branch. 
a. `50000/- only 

b. `200000/- 

c. Any amount 
d. Not permitted from host branch 

e. Only transfer entry is permitted 

Ans (C) 
 

15. X staff has issued a cheque of `50000/- against his OD account in favour of Y. Cheque 

will be encashed at 
a. All host branch of Canara Bank 

b. Anywhere in India 

c. Only at Base Branch. 

d. Only after endorsement 

e. Not possible 

Ans (C) 
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16. For 'CANARA BLOG', which is correct 

a. A website designed to share information of our Bank staff. 

b. Accessed at http://sp.canarabank.com/canarablog 

c. Canara Bank's blog 

d. All the above 

e. None of the above 

Ans (D) 
 

17. Regarding FP 9540 in FCR (CBS) which one is correct 

a. Option used to debit loan account for Insurance Premium 

b. Processing charge 

c. Disbursement of loan 

d. Used for reverse wrong credit made earlier in the loan account 

e. Legal charges paid to the advocate. 

Ans (D) 
 

18. DD payment under CBS environment which is correct 

a. Can be paid by any CBS branch. 

b. Paid by debiting BADDs (GL 123500110) 

c. At Account Section/ Drawee branch 

d. All the above 

e. None of the above 

Ans (A) 
 

19. Cash BAR should be adjusted on 

a. T+2 days 

b. T+1 day 

c. T+0 day 

d. Within a fortnight on receipt of IBA 

e. None of the above 

Ans (C) 
 

20. TDS on Time Deposit are on 

a. Quarterly 

b. Half Yearly 

c. Monthly 

d. On last day of FY at the time of Maturity/Premature closure/prematurity 

extension/Part withdrawal which events takes place earlier 

Ans (D) 
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21. For exemption of TDS ,Form 15G/H should be captured in FP TDS03 

a. In the beginning of FY 

b. For every new deposit opened 

c. Renewed in different product code 

d. All the above 

Ans (D) 
 

22. KDR receipt in modified format (w.e.f 01.05.2012) should be printed in FP 

a. TD043 

b. TD046 

c. TD048 

d. TD024 

e. TD039 

Ans (B) 
 

23. SMS/e-mail alert facility in CBS by registering Mobile no & email in FP CIM09 for getting 

a. Debit Alert 

b. Credit Alert 

c. Issuance of cheque book 

d. All the above 

e. None of the above 

Ans (D) 

24. Fees recovered from the borrower for registering our security interest with Central Registry 

(CERSAI) should be parked in GL Head 

a. 209271051 

b. 209272434 

c. 209272431 

d. Not to park, directly remit to H.O. 

e. No fee payable 

Ans (A) 
 

25. Debt Restructuring A/C through LN521/AL521 in CBS should be captured in 

a. BA020 

b. BAM83 

c. BAM59 

d. BAM72 

e. None 

Ans (D) 
 

 

 

 

 

 

 

NextDayJob.org Page 90 



Fb.com/NextDayJob  

 

26. Maximum number of transactions permitted for NEFT in CBS is 

a. One 

b. Ten 

c. Fifty 

d. Any Number 

e. 100 

Ans (D) 
 

27. For Bulk upload facility in NEFT which one is not correct 

a. Any number of transaction is possible 

b. Created under FP ST045 & BA 451 

c. Not extended for IndoNepal & card payment 

d. BBC check is not provided for 

e. Time saving 

Ans (C) 
 

28. Computer operator A in CBS environment can excessive self passing power for cash cheque 

upto 

a. `20000 

b. `15000 

c. `10000 

d. Any amount 

e. No power 

Ans (C) 
 

29. Single Window Operator A can pass payment 

a. For other staff A/c 

b. Own A/c 

c. GC payment 

d. WOF payment 

e. None of the above 

Ans (E) 

 

30. Report ID TP6009 is provided for 

a. Cash Receipt 

b. Cash payment 

c. Transfer made by teller A 

d. All the above 

Ans (D) 
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31. Premature closure/ part withdrawal of Canara Flexi deposits, penalty imposed is 

a. 1% 

b. 2% 

c. Waived w.e.f01.05.2012 

d. No such system 

Ans (C) 
 

32. GEFU- Generic External File Upload facility for bulk opening of Loan A/c in FCR-Agriculture 

linked to security code 

a.701-Crops 

b.704-Gold Jewellary 

c.27-Land & Building 

d.All the above 

e. None of the above 

Ans.(D) 
 

33. Our Bank has introduced Internet Banking Kit (Welcome Kit) to provide Net Banking password 

immediately on day of opening of the account for 

a. Retail Customer only 

b. Corporate Customer only 

c. Both the above 

d. None of the above 

Ans (C) 
 

34. Which one of the following is true about ATM50 option 

a. No authorization is required 

b. Teller has to initiate the transaction and supervisor has to authorize 

c. Should be used by any CBS branch 

d. Used by only ATM attached to branch or Nodal cell 

e. (b) & (d) both 

Ans (E) 

 

35. Processing of STR alert in AML package is now vested to 

a. Branch 

b. Circle Office 

c. Head Office 

d. DIT Wing 

e. None of the above 

Ans (B) 
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36. e-token is used for 

a. Authorize-RTGS/NEFT message 

b. ROC- MCA 21 authorization 

c. CERSAI Authorization 

d. Both (b) and (c) 

e. None of the above 

Ans (D) 
 

37. Regarding RTGS-STP in CBS, which one is not correct 

a. RTGS failed message should be Accept/Reject within 1 ½ Hrs from time of receipt 

b. Outward return message automatically credited to the senders account 

c. Outward RTGS message on authorized/released System debits CASA/GL account and 

credit HOBA on 1499 

d. Account entry failed (AFD) & Bank Payment (298R42) is credited to RTGS GL 209272434 

e. For Rs.100 Cr & above TWO Authorizers & One Releaser is required. 

Ans.(C) 
 

38. MIS-Regulatory requirement in CBS under CIM09/BAM 83/BA020/M-button of FCC , which 

option is correct 

a. Concerned Officials/Manager is responsible for accuracy 

b. Any change/modifications in the master data should be recorded with reason & 

authenticated by the appropriate authority 

c. Proper records for change to be maintained 

d. All the above 

e. None of the above 

Ans.(D) 
 

39. Which one is not correct regarding VSS- Video Surveillance System for ATMs 

a. Checking of VSS camera fitted to ATM on weekly basis 

b. Copy image/data on to a removable media- USB Hard Disk one in a month.(on 20th of 

every month). 

c. Preserved the same in FBR safe for a minimum of 90 days and it can be recycled 

subsequently. 

d. For Offsite ATM location backup data at Base Branch/Nodal Branch. 

e. All the above. 

Ans.(E) 
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40. Levy of Service charge on Debit card holders on usage of our branch debit card at other Bank's 

ATM @ Financial Transaction- `20 + S.T/Transaction & Non Financial Transaction- `10 + 

S.T/Transaction 

a. Waived for all A/C holder 

b. Waived for SB A/C holder for first five transactions (financial and Non-financial). 

c. Waived for SB A/C holder for first six transactions in a month (financial and Non- 

financial). 

d. A & b above 

e. None of the above 

Ans.(D) 
 

41. What is the advantage of e-payment of customs duty, which our Bank has introduced in 103 

designated branches 

a. Safe & secure mode of making payment 

b. No paper challan filling 

c. 24 x 7 basis service 

d. Free of charges 

e. All the above 

Ans.(E) 
 

42. What is DMS?. 

a. Desktop Management Software. 

b. Desktop Management Service 

c. Desktop Management Solution 

d. Desktop Managerial Solution 

e. Desktop Managerial Software. 

Ans.(C) 
 

 

 

43. For BBC (Branch Batch Closure) check which is not required. 

a. GL 616- GL Navigation balance alert report. 

b. CH-704- 

c. BA 121- 

d. BA001 

e. BO: Report Id :124921-Cash Receipt over Rs.1 Lac received in CA/OD/CC a/c 

Ans.(D) 
 

 

 

 

 

 

 

 

NextDayJob.org Page 94 

RAMZAN BALOCH
Typewriter
RAMZAN BALOCH
ramzanbaloch7667@gmail.com
03316791432
Herronk Kech Turbat Balochistan
07-03-2017

RAMZAN BALOCH
Typewriter



Fb.com/NextDayJob  

 

44. From the control angle, Branch In Charge/  Line manager to verify on daily basis- 

a. TP 5029 

b. SM 6009 

c. SM 5003 

d. SM 6000 

e. All the above 

Ans.(E) 
 

45. KYC details of Customer has to be captured in FP 

a. CIM09 

b. CIM 22 

c. CIM13 

d. CIM 50 

e. All the above 

Ans.(D) 
 

46. Benefits to DMS are: 

a. Improved system performance 

b.Productive installation Microsoft Security Patches &service packs 

c.Virus free system 

d.Secured working environment 

e. All of the above 

Ans.(E) 
 

47. Under DMS Envirnment, user cannot do the following: 

a. Install or uninstall applications 

b. Share folder/drive 

c.use VNC for remote connection 

d.Use CD/DVD, Floppy &USB storage devices 

e. All of the above 

Ans. (E) 
 

48. Net Meeting is- 

a. Chatting on internet 

b. Remote desktop connection under DMS environment 

c.Used for troubleshooting purpose 

d.Both b&c 

e.None of the above 

Ans.(D) 
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49.In CBS Outward Clearing ,online Cheque Return option(6560) should be used- 

a. Before running Value date clearing(ST001) 

b. After running Value date clearing 

c. Not necessary to opt 

d. Check return to be handled manually 

e. Choice of LPC/Branch 

Ans.(A) 
 

 

50. Which one of the following is not correct about CBS Fast Path-CIM15? 

a. Facilitate the Branch to maintain customer manually for NPA classification 

b. Branch can create/delete as well as authorize the record 

c.BO report ID:280086 to know the details of such customers maintained 

d.History of such customers maintained can be known by BO report :280085 

e.CIM15 should used only in applicable cases duly obtaining approval of the 

concerned authority. 

Ans.(B) 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

NextDayJob.org Page 96 

RAMZAN BALOCH
Typewriter
RAMZAN BALOCH
ramzanbaloch7667@gmail.com
03316791432
Herronk Kech Turbat Balochistan
07-03-2017

RAMZAN BALOCH
Typewriter




